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Preface 

Where to Find Help 

Online Help 
Access the online Help screens to find detailed information on each feature in Medisoft. Online 
Help is available in two different ways: 

 • Context-Sensitive Help: For help in a particular part of Medisoft, click the area for which you 
need help and press F1. The help topic for that area will appear. 

 • Main Help File: To access the main help file, click the Help menu and click Medisoft Help. The 
main help file will appear, displaying the Contents tab. Use the Contents tab to view 
categorized topics for Medisoft. Use the Index and Search tabs to find out additional or specific 
information about Medisoft. 

Training 
There are various training options available. Please contact your local Value-Added Reseller or the 
Medisoft Sales Department at 800-333-4747 for information concerning these options. 

Independent Value-Added Resellers 
There are Value-Added Resellers in your area who are knowledgeable and efficient in selling, 
installing, troubleshooting, and supporting your Medisoft program. You can contact the Medisoft 
Sales Department at 800-333-4747 for the name of a qualified Value-Added Reseller in your area 
to give you hands-on help or search the Medisoft website at www.medisoft.com for a reseller in 
your area. 

Technical Support 
Call Support at (855) 675-8326 between the hours of 8:00 a.m. and 8:00 p.m Eastern Standard 
Time. 

http://www.medisoft.com
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Medisoft Versions

Medisoft comes in three versions:

Product Features

Basic Offers basic features for processing patient visits, claims, payments, 
and reporting.

Advanced Offers all that Basic does but provides greater reporting power, the 
ability to process secondary claims, as well as sending patient 
statements and collections processing.

Network Professional Offers all the features of Basic and Advanced, but enables you to 
integrate with an Electronic Health Records (EHR) system.

In addition, with this version only, you can use a mobile device such 
as an iPad to connect to your practice data.
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Chapter 1 - Navigating in Medisoft

In this chapter, you will learn about the basics of navigating in Medisoft, using the menus and 
keyboard shortcuts.

Toolbars

There are four toolbars that you use to help you navigate in Medisoft.  

Title Bar
The top bar on the screen is the Title bar and it displays the name of the active program and 
contains Minimize, Maximize, and Close buttons on the right side. 

Figure 1.  Title Bar

Menu Bar 

Just below the Title bar is the Menu bar, which shows categories of activities available in Medisoft. 
Click one of the headings, such as File, Edit, Activities, Lists, Reports, Tools, screen, and Help, to 
open a submenu with a list of all the options available in that category.  For more information on 
each drop-down menu, see “Menus” on page 4.

Figure 2.  Menu Bar

Toolbar
Below the menu bar is the toolbar with an assortment of speed buttons (or icons) that are shortcuts 
to accessing options in Medisoft.  

Figure 3.  Toolbar
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Select the option you want by clicking the appropriate button. To see the function of the toolbar 
button, hover the mouse cursor over it. The value will appear.

Figure 4.  Medisoft toolbar with icon highlighted

Customizing the Toolbar
You can customize the toolbar to fit your needs. You can change the order of the buttons in the 
toolbar or remove them so they do not appear. You can create a new toolbar with only the buttons 
or file names that you want. In addition, you can move the toolbar to the top, bottom, or either side 
of the screen or return it to its original position and layout.  

To customize the toolbar:
1. Right-click an open space on the toolbar and click Customize. The Customize screen 

appears.

Figure 5.  Customize screen

2. Use the options on the tabs to make your choices. 

3. Click the Close button when you are done.
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Chapter 1 - Navigating in Medisoft Shortcut Bar

Shortcut Bar

Figure 6.  Shortcut Bar

At the bottom of the screen, above the Status bar, is a shortcut bar that describes the available 
shortcut function keys available in the active screen. This bar may also be referred to as the 
“function help bar.” 
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Menus

There are eight drop-down menus from the menubar that have options that allow you to work in 
Medisoft.

File Menu

Figure 7.  File menu

The File menu contains options for managing your practice files.  
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Chapter 1 - Navigating in Medisoft Edit Menu

Edit Menu

Figure 8.  Edit menu

The functions of the Edit menu are Cut, Copy, Paste, and Delete.    

Activities Menu

Figure 9.  Activities menu

You will use the options on this menu for much of your daily routine. Here is where you enter 
transactions and payments, create claims, view balances, and open Office Hours. 
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Lists Menu

Figure 10.  Lists menu

This menu provides access to the various list screens available in Medisoft. Here is where you will 
set up your patients, providers, insurance companies, diagnosis codes, and other basic data you 
will need to file claims and send statements to patients.
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Chapter 1 - Navigating in Medisoft Reports Menu

Reports Menu

Figure 11.  Reports menu

Reports within Medisoft are accessible through the Reports menu. A wide variety of reports enable 
to you to track your practice and see the state of your practice at any time. 



Medisoft 21 Service Pack 1
8  February 2017

Tools Menu Chapter 1 - Navigating in Medisoft

Tools Menu

Figure 12.  Tools menu

The options available in this menu help you access peripheral programs and information to help 
you manage your practice.

Window Menu

Figure 13.  Window menu

This menu contains options that control the display of screens in Medisoft.  
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Help Menu

Figure 14.  Help menu

The Help menu contains access to information on how to use Medisoft, as well as how to register.  
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Keystrokes and Shortcuts

Special keyboard shortcuts reduce the number of times you have to click the mouse or press keys 
to accomplish a task. 

Common Keystrokes

Keystrokes - List screens

Keystroke Action
F1 Opens Help files in most screens.
ESC Closes or cancels the current function or screen.
F3 Saves whatever you are working on.
F6 Opens a search screen
F7 Opens the Quick Ledger screen. For more information on this screen, 

see “Quick Ledger” on page 101.
F8 Opens a screen to create a new record.
F9 Opens a screen to edit the selected record.
F11 Opens the Quick Balance screen. For more information on this 

screen, see “Quick Balance ” on page 103.
SPACEBAR Toggles a check box (check/uncheck).
ENTER Depends on settings in the Program Options screen. For more 

information, see “Program Options” on page 173.
CTRL + S Toggles the Sidebar display.
CTRL + X Cuts the selected text.
CTRL + C Copies the selected text.
CTRL + V Pastes the text.
ALT + DOWN ARROW Opens drop-down lists.

Keystroke Action
F2 Changes the value in the field.
F3 Saves the record.
F8 Creates a new record.
F9 Edits the selected record.
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Chapter 1 - Navigating in Medisoft Keystrokes - Transaction Entry

Keystrokes - Transaction Entry

Keystrokes - Eligibility 

Keystroke Action 
F2 Opens the MultiLink screen. For more information on this screen, see 

“MultiLink Codes” on page 75.
F4 Opens the Apply Payment to Charges screen. For more information on this 

screen, see “Applying a Payment” on page 127.
F5 Opens the Transaction Documentation screen.

Keystroke Action
F10 Opens the Eligibility Verification Results screen when Eligibility is enabled. For 

more information on this screen, see “Eligibility Verification” on page 139.
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Chapter 2 - Medisoft at a Glance

This chapter provides a brief overview of the setup and use of Medisoft, in the general order in 
which you will want to set up your practice. For instance, you will first want to enter basic 
information on your practice, such as practice name and address. Then, you’ll move on to entering 
information on the physicians in your practice (Providers), the insurance carriers your patients 
have, and then diagnosis and procedure codes. 

For more detail on each area of the program, use the following table:

For more information about setting up... see...

your practice “Creating a Practice and Setup Overview” 
on page 23 and “Entering Practice 
Information” on page 41.

your providers “Setting up Providers and Provider 
Classes” on page 47.

referring providers “Referring Provider Records” on page 53.

insurance carriers “Insurance Classes and Insurance 
Carriers” on page 57.

facilities “Facility Information” on page 65.

addresses “Attorney, Employer, or Other Addresses ” 
on page 69.

procedure/payment/adjustment codes “Procedure, Payment, Adjustment, and 
Diagnosis Codes” on page 71.

diagnosis codes “Diagnosis Codes” on page 75.

patients “Patients” on page 83.
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Setting up Your Practice Overview

You will first set up your practice. The Practice Information screen contains the basic information on 
your practice.

Figure 15.  Practice Information screen

The Provider screen contains important information about the providers/physicians who are part of 
your practice.  

Figure 16.  Provider screen

Each provider in the practice needs to have his or her own record set up in the database. 
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Chapter 2 - Medisoft at a Glance Setting up Your Practice Overview

The Referring Provider screen contains information about the referring providers associated with 
your practice.

Figure 17.  Referring Provider screen

You will use the Insurance Carrier screen to enter insurance carrier records. Keep a complete 
record of each ot your insurance carriers so that claims will be filed properly. 

Figure 18.  Insurance Carrier screen
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The Facility screen contains information about the labs and facilities associated with your practice. 
Use the fields on this screen to enter information that is specific to the facility for claim filing 
purposes.

Figure 19.  Facility screen
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Chapter 2 - Medisoft at a Glance Setting up Your Practice Overview

The Addresses screen is used to enter address information important to your practice, such as 
addresses of attorneys, employers, or referral sources.

Figure 20.  Address screen
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The Diagnosis List screen displays diagnosis codes that have been set up for the practice. You can 
also identify codes that are HIPAA Approved. Use diagnosis codes in patient records, as well as 
during transaction entry. These will be part of each claim that is filed.

Figure 21.  Diagnosis screen
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Chapter 2 - Medisoft at a Glance Setting up Your Practice Overview

You will use the Procedure/Payment/Adjustment Code screen to enter and edit procedure codes. 

Figure 22.  Procedure/Payment/Adjustment screen
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The Patient screen is the main space for entering/editing patient and information.  

Figure 23.  Patient/Guarantor screen
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Chapter 2 - Medisoft at a Glance Entering Transactions and Payments

Entering Transactions and Payments

You enter charges via the Transaction Entry screen. You can also apply payments using this 
feature. 

Figure 24.  Transaction Entry screen

Generating Claims and Statements

Claims processing centers on the Claim Management screen from which you can create, edit, and 
print/send claims. Medisoft also provides support for UB-04 claims. 

Figure 25.  Claim Management screen
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After you have created claims in Medisoft, you can either print them from Medisoft or file them 
electronically using Revenue Management (see “Electronic Claims Processing” on page 139), an 
integrated electronic claims filing application.

You can use the Statement Management screen (available in Medisoft Advanced or Network 
Professional) to create billing statements for patients. 

Figure 26.  Statement Management screen
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Chapter 3 - Creating a Practice and Setup 
Overview

In this chapter you will learn how to create a database for your practice and learn about program 
options. 

Creating a Practice

The first step in setting up Medisoft is creating the database that holds the data in your practice.  

Creating the Practice Database
1. When you first open Medisoft after installation, you must either create a new data set (if this is 

the first time you have ever installed Medisoft) or convert previous Medisoft data. 

If you have been using Medisoft Version 5.5x or 5.6x and above and have just installed Version 
21, a message displays stating that data must be converted before you can access Medisoft. If 
you have not already created a backup on your existing data, create a backup now. Then, click 
the OK button to perform the automatic conversion.  

If you work with multiple practices, each will have to be converted.    

2. If you choose to create a new data set, the Create a new set of data screen appears. 

Figure 27.  Create a new set of data

3. Fill in the practice name and the practice data path. The data path is the location within the 
MediData folder in which the practice data is stored.
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4. When you click the Create button, the Practice Information screen appears. On this screen on 
the Practice tab, enter your basic practice information such as the name of the practice, 
address, and telephone number.

Figure 28.  Practice Information screen

For more detailed information on this screen, see “Entering Basic Practice Information” on page 41.

Creating Multiple Practices
It is not necessary to install Medisoft for each new practice. When the first practice is set up, 
Medisoft assumes there is only one practice and establishes a default directory for the data for that 
practice. Each time you set up an additional data set with totally unrelated patients and procedure 
files, you must create a different subdirectory. This establishes a completely separate database for 
the new practice.  

Changing the Program Date
You can change the program date for back-dating a large number of transactions. This affects all 
dates in Medisoft except the Date Created setting, which always reflects the System date.  
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Opening a Practice

To open a practice: 
1. On the File menu, select the appropriate option.

Figure 29.  Open Practice screen

2. Choose the practice you want to open and click the OK button.  
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Setup Overview

Steps to setting up your basic practice can be found at “Entering Basic Practice Information” on 
page 41.

Once you have created your practice database, the next step is to enter data into each of the 
different areas of Medisoft, such as insurance carrier records in the Insurance Carrier screen, 
procedure codes in the Procedure, Payment, and Adjustment Codes screen, and so on. 

Here is a sequence for practice setup that will help you enter your practice information in the most 
economical way.  

 • Creating rules overview

 • Set up security

 • Set up preferences

 • Enter basic practice information

 • Set up EDI Receivers for electronic claims and eligibility

 • Enter insurance carrier records

 • Enter facility records

 • Enter provider records

 • Enter referring provider records 

 • Enter other address records

 • Enter procedure codes and multi-link codes

 • Enter diagnosis codes

 • Enter billing codes

 • Enter guarantor and patient records

Keeping in mind your practice structure and your filing needs will help you set up your practice. 

Creating Rules Overview
Medisoft claim processing for both print and electronic claims depends on a series of flexible rules 
that you define. When setting up your practice, you will create a series of grid entries (rules) on the 
Practice IDs screen (see “Entering a Practice IDs Rule” on page 42) and Provider IDs screen (see 
“Entering Provider IDs Rules” on page 49). Depending on your practice, you may also use the 
Facility IDs screen (see “Entering Facility Information” on page 65) and Referring Physician IDs 
screens (see “Entering Referring Provider Rules” on page 55). These rules contain your basic 
practice information, such as group or individual NPI numbers, taxonomy, tax IDs, and claim filing 
status (group or individual). They also connect this information to the insurance companies that 
your patients use and the physicians in your practice.

You begin by creating rules for each provider on the Provider IDs screen and at least one rule on 
the Practice IDs screen. These rules will contain information that would apply to the most generic 
situations. Then, you will create other rules that apply to a specific insurance company, insurance 
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category, facility, provider, and so on. See “If you are a solo provider (file claims as an individual)” 
on page 27 and “If you are a group (file claims as a group)” on page 30 for more detailed 
information.

When you create claims using Revenue Management, Medisoft gathers data for each claim using 
these rules, looking first at rules that apply to an insurance company or provider. It will compare 
these rules against rules set up for facilities or referring physicians. The specific order in which 
Medisoft analyzes rules follows the order of fields on the level it is working on. For instance, when 
looking at practice information, it will look first at Providers, then Insurance Carrier, and so on, 
moving from left to right on the grid. 

Figure 30.  Practice IDs screen with grid headings highlighted

For instance, if you are setting up a group practice with three physicians,

1. Create at least one rule on the Practice IDs screen for general information that is common to 
all claims. Apply this rule to all providers, all insurance companies, and all facilities (assuming 
you have no facilities associated with your practice or all facilities would use the same details). 
Include your group NPI, taxonomy, and tax ID numbers. 

2. Second, create one rule on the Providers IDs screen for each provider (a total of three rules). 
You must include one rule for each provider on the Provider IDs screen since claim filing status 
(individual or group) is specified there. Each of these rules would be general and could apply 
to all insurance companies and facilities. Select Group for your claim type and select From 
Practice to pull NPI, taxonomy, and Tax IDs from the Practice IDs screen. 

3. If one of the insurance companies requires a legacy identifier, create a second entry on the 
Practice IDs screen. By creating a second entry on this screen instead of the Provider IDs 
screen, you save time and effort. This one rule can be applied to all the providers at the 
practice level, instead of creating a rule for each provider at the provider level. To do this, for 
this second Practice IDs rule, select the specific insurance company and select all providers. 
Importantly, include your NPI, taxonomy, and Tax IDs since each rule needs to be complete. 
Finally, enter the legacy number the insurance company requires. When the application 
gathers claim data, it will select this row for the specific insurance company and pull the data 
for the claim.

If you are a solo provider (file claims as an individual)
As a solo provider, you have two options when entering key ID numbers, such as NPI, taxonomy, 
and tax ID/social security number.
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 • Enter this information at the practice level using the Practice IDs screen (see “Entering a 
Practice IDs Rule” on page 42). With this method, enter these numbers on the Practice ID 
screen. Then, select From Practice for all values on the Provider IDs screen (see “Entering 
Provider IDs Rules” on page 49).

Figure 31.  New Practice ID screen

Enter this information at the provider level using the Provider IDs screen (see “Entering Provider 
IDs Rules” on page 49). In this case, on the Practice IDs screen, select None for NPI, taxonomy, 
tax ID/social security number, and so on, and enter a minimal amount of information. Then, on the 
Providers screen, specify your NPI, taxonomy, tax ID/social security number, and so on. Also, 
select Individual for the File Claim as.The result will be the same and Medisoft will correctly pull 
these IDs when filing claims.

Figure 32.  New Provider IDs screen
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NPI Considerations
If you have the same pay-to address as your billing address, you can enter your NPI information on 
the Practice IDs screen. Then, select From Practice on the Providers IDs screen. This will ensure 
that the NPI number appears on all claims.

If you have different billing information and pay to information (see “Entering Practice Information 
for a Billing Service” on page 44), enter your NPI information on the Practice IDs screen. Also, 
enter any unique NPI on the Provider IDs screen. 

If you have insurance companies that require mixed NPI numbers (some require individual while 
some require group), enter your group NPI number on the Practice IDs screen. Then, create 
several rules on the Provider IDs screen specific to the insurance companies that require mixed 
NPI numbers. For insurance companies that require the group NPI, select From Practice for the 
NPI number. This will pull that number from the Practice IDs screen. For insurance companies that 
require an individual NPI number, select National Provider ID and enter the number on the Provider 
IDs screen.

Insurance Company Considerations
You might only need one rule (grid entry). Most likely though, you will probably have at least one or 
more insurance companies that require different information. In that case, you must create other 
rules that are specific to that insurance company and the information needed, for instance a legacy 
qualifier such as a medicare number, as shown in Figure 33.

Figure 33.  Edit Provider IDs screen, specific to an insurance company

Each of these additional rules needs to be complete since the claims processing pulls all the 
information in a rule and not just one field. An incomplete rule (for instance, no NPI number) will 
leave fields empty in the claim, causing rejection. In the case of Figure 33, you would need to 
include the NPI number, Taxonomy number, and Social Security Number since those were 
included in the initial rule using the Provider IDs screen (see Figure 32). If you used the Practice 
IDs screen, you could select From Practice for these numbers and you would not need to specify 
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them on the Provider IDs screen since Medisoft would pull these values from the Practice IDs 
screen. 

If an insurance company requires taxonomy, you must create a rule on the Practice IDs screen for 
that insurance carrier and enter the taxonomy number there. Then, open the Insurance Companies 
screen and select the Send Practice Taxonomy in Loop 2000A checkbox. If your practice requires 
dual taxonomy, then you must also create a rule on the Provider IDs screen for that number, 
specifying the provider and insurance company.  

Facility Considerations
If you have facilities attached to your practice, you must create rules on the Facility ID screen for 
any numbers that are specific to that facility. If you have entered a separate NPI number for a 
facility and need to send facility billing information, specify the type of facility and qualifier, 
including the unique facility NPI number. If this information is sent on the claim, select the Send 
Facility on Claim check box and do not include any other data.

Referring Physician Considerations
If your practice has referring physicians, create records for them on the Referring Physicians 
screen and use the Referring Physician IDs screen to enter any numbers unique to a referring 
physician. 

If you are a group (file claims as a group)
First, complete at least one rule on the Practice IDs screen for the practice. Then, create at least 
one rule on the Provider IDs screen for each provider. Set your claim filing status on the Provider 
IDs screen by selecting Group for each provider in your practice.

Figure 34.  New Provider IDs screen with Group selected
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If you have a provider that files claims using a personal NPI number for a specific insurance 
company, create an extra rule for this provider, specifying that particular insurance company. Enter 
the unique NPI number for that rule. 

Figure 35.  New Provider IDs screen with NPI for specific insurance company

NPI Considerations
Enter your NPI information on the Practice IDs screen. Then, on the Provider IDs screen, select 
From Practice.

If you have insurance companies that require mixed NPI numbers (some require individual while 
some require a group), enter your group NPI number on the Practice IDs screen. Then, create 
several rules on the Provider IDs screen specific to the insurance companies that require mixed 
NPI numbers. For insurance companies that require the group NPI, select From Practice for the 
NPI number. This will pull that number from the Practice IDs screen. For insurance companies that 
require an individual NPI number, select National Provider ID and enter the number on the Provider 
IDs screen.

Insurance Company Considerations
If an insurance company requires dual taxonomy, you must create a rule on the Practice IDs screen 
for that insurance company and enter the taxonomy number there. Then, open the Insurance 
Companies screen and select the Send Practice Taxonomy in Loop 2000A checkbox. 

Most likely though, you will probably have at least one or more insurance companies that require 
different information. In that case, you must create other rules that are specific to that insurance 
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company and the information needed, for instance a legacy qualifier such as a medicare number, 
as shown in Figure 36.

Figure 36.  New Provider IDs screen, specific to an insurance company

Each of these additional rules needs to be complete since the claims processing pulls all the 
information in a rule and not just one field. An incomplete rule (for instance, no NPI number) will 
leave fields empty in the claim, causing rejection. In the case of Figure 36, you would need to 
include the NPI number, Taxonomy number, and Social Security Number since those were 
included in the initial rule using the Provider IDs screen (see Figure 35). If you used the Practice 
IDs screen, you could select From Practice for these numbers and you would not need to specify 
them on the Provider IDs screen since Medisoft would pull these values from the Practice IDs 
screen. 

Facility Considerations
If you have facilities attached to your practice, you must create rules on the Facility ID screen for 
any numbers that are specific to that facility. If you have entered a separate NPI number for a 
facility and need to send facility billing information, specify the type of facility and qualifier, 
including the unique facility NPI number. If this information is sent on the claim, select the Send 
Facility on Claim check box and do not include any other data.

Referring Physician Considerations
If your practice has referring physicians, create records for them on the Referring Physicians 
screen and use the Referring Physician IDs screen to enter any numbers unique to a referring 
physician. 
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Setting Program Options

The Program Options screen contains various default settings that affect operations in different 
parts of the program.  

To open Program Options:
 • On the File menu, click Program Options.

Figure 37.  Program Options screen

TIP: For most users the default settings on the various tabs on the screen are sufficient for initial 
use. You can customize these settings at a later date.  

 • Each tab features settings for different functional elements in the application. For more 
information on the available options and settings, see: 

 • “General Tab” on page 173

 • “Data Entry Tab” on page 174

 • “Payment Application Tab ” on page 175

 • “Aging Reports Tab” on page 176

 • “HIPAA Tab/ICD 10” on page 177

 • “Color-Coding Tab ” on page 178

 • “Billing Tab ” on page 179

 • “Audit Tab ” on page 180
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 • “BillFlash Tab ” on page 181
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Basic security in Medisoft is practice-based, with each practice having various users and groups. 
Multiple practices require security setup for each database. Setting up security is a two-step 
process:

1. Create users, giving them a login name, password, and access level (1-5). 

The access level determines which areas of the practice a user can access. Level 1 users 
have the most access, while Level 5 users have the least access.

The first user you will create is the system administrator, who must be a level 1 and have 
access to all areas of the practice.

2. Assign permissions to users, using the five access levels.

Creating Users

You create users of the practice in the User Entry screen. To create a practice

1. On the File menu, click Security Setup. The Security Setup screen appears. This screen 
shows you a list of all users.

2. Click the New button. The User Entry screen appears.

Figure 38.  User Entry screen

3. Complete the fields on the screen.
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4. Click the Save button. The Security Setup screen appears and shows you the new user.

Figure 39.  Security Setup screen
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Login/Password Management

Use Login/Password Management to set the requirements and application of login rights and 
password usage. For example, you can set the length of valid passwords, the valid time frame in 
which a password can be used before it has to be changed, how long a user has to wait before 
reusing a password, and so on. 

Figure 40.  Login/Password Management screen
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Setting Permissions

NOTE: This is an Advanced or Network Professional feature. 

The Permissions feature provides five levels of access to Medisoft. Once you have created at least 
one user for your practice and logged into your practice using someone’s login and password, the 
Permissions options will be available.

To set permissions:
1. On the File menu, click Permissions. The Medisoft Security Permissions screen appears.

Figure 41.  Medisoft Security Permissions screen

This screen comprises two sections:

 • The screen section displays all the areas of the practice for which security can be set up. 

 • The Process section shows the individual elements, features, or screens that make up the 
selected area in the screen section. 

Level 1 is for unlimited access and is designed to be used exclusively by the Supervisor or 
administrator to restrict access to Medisoft. For Levels 2, 3, 4, and 5, the supervisor defines 
what access goes with each level and assigns users based on that.  

2. Select a program area in the screen section. The options for that area appear in the Process 
section.
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3. Select or clear check boxes for each option and level in the Process section of the screen.

4. Click the Close button when you are done.

The Security Supervisor, who has unlimited access and full control of security, can assign or 
remove rights for any level of security, with one exception. Level 1 access cannot be removed from 
any of the three options listed in the Process section of the Permissions screen when Security is 
selected in the screen section. 
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Enter basic practice information that the system uses for reports, statements, and filing claims. Be 
sure to enter complete information so that your claims will be complete. 

Entering Basic Practice Information

To enter practice information:
1. On the File menu, click Practice Information. The Practice Information screen appears. 

Figure 42.  Practice Information screen

2. On the Practice tab, enter the contact information for the practice. The address must be a 
physical address, not a P.O. Box. If you have a P.O. Box to which payments are sent, that 
information will go in the Practice Pay-To tab.

3. From the Type list select your practice type. 
When you select Chiropractic, the Level of Subluxation field appears in the Diagnosis tab of 
the Case screen for entering the level of subluxation. In addition, five treatment fields are 
displayed in the Miscellaneous tab of the Case screen.

4. In the Federal Tax ID field, enter the practice's federal tax ID. 

5. From Practice Type, select Individual or Group. 

6. From Entity Type, select Person or Non-Person.  

NOTE: Extra 1 and Extra 2 are optional fields that may be used if a carrier requires extra data on a 
claim. They can hold up to 30 characters. 
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Entering a Practice IDs Rule

Use the Practice IDs tab and Practice IDs grid to enter or edit key data elements associated with 
your practice (tax ID/social security number, NPI, taxonomy, legacy numbers). You will set up at 
least one rule on the Practice IDs grid and associate this information to all providers, insurance 
carriers, and all facilities. For more information on entering data on the IDs grid, see “Creating 
Rules Overview” on page 26.

1. Select the Practice IDs tab.The Practice IDs tab appears.

Figure 43.  Practice IDs screen

2. Click the New button to create a new rule. 

--OR--

To edit an entry, select the record on the grid and click the Edit button. 

Figure 44.  New Practice ID screen
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3. Select the All, Provider, or Provider Class button. 

4. Select the All button to apply the rule to all providers associated with the practice. 

To apply the rule to a specific provider, select the Provider button and click the magnifying 
glass to select the specific provider. 

To apply the rule to a specific provider class, select the Provider Class button and click the 
magnifying glass to select the provider class.

5. Select the All, Insurance Carrier, or Insurance Class button. 

Select the All button to apply the rule to all insurance carriers associated with the practice. 

To apply the rule to a specific insurance company, select the Insurance Carrier button and 
click the magnifying glass to select the insurance carrier. 

To apply the rule to a specific insurance class, select the Insurance Class button and click the 
magnifying glass to select the insurance class. 

6. Select either the All or Facility button. 

7. Select National Provider ID and enter an NPI number to associate that NPI number with the 
rule.

TIP: if your practice has a group NPI number, enter it here. Then, if providers in your office need to 
file claims as individuals, you can create a rule for that provider using the provider's individual NPI 
number that you enter on the Provider IDs grid. 

8. Select either None or Taxonomy. 

9. Select the Tax Identifier button and enter the tax ID number to associate with the rule.

10. Select the Social Security Number button and enter the social security number to associate 
with the rule.   

11. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using the 
Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet filing 
requirements with an insurance carrier(s).

12. Click the Save button.
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Entering Practice Information for a Billing Service

Billing Services
If you are a billing service, enter your client’s information in the Practice tab. Enter your information 
in the Practice Pay-To tab. If you want to use Medisoft to keep track of your own accounts 
receivables, a separate database can be set up with each client listed as a patient. Separate 
procedure codes can be created to cover the various services of your billing service.

To set up a billing service:
1. On the File menu, click Practice Information. The Practice Information screen appears.

2. Select the Practice Pay-To tab.

Figure 45.  Practice Information screen - Practice Pay-To tab

3. Enter the pay to information in the Practice Name, Street, City, State, Zip Code fields.

4. Click the Save button.

BillFlash Users

BillFlash is the online service available to you if you want to send your statements electronically. 
Once you enroll with BillFlash, you can create statements and upload them to BillFlash. BillFlash 
then takes care of printing and sending them to your patients.

If you use Bill Flash for electronic statement processing, complete the Statement Pay To tab. Data 
on this tab is used to create a separate pay-to address location for the statements, for instance, a 
PO Box instead of a physical address.

To complete the Statement Pay-To tab: 
1. On the File menu, click Practice Information. The Practice Information screen appears.
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2. Select the Statement Pay-To tab.

Figure 46.  Practice Information screen - Statement Pay-To tab

3. Enter the pay to information in the Practice Name, Street, City, State, Zip Code fields.

NOTE: the Extra 1 and Extra 2 fields are only used if a carrier requires extra data on a claim. 

4. Click the Save button.
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EDI Receiver Records

The EDI Receiver screen displays parameters used for transmitting information to a clearinghouse.

To open the EDI Receiver screen:
 • On the Lists menu, click EDI Receivers.

The settings in Medisoft on the EDI Receiver screen are used for setting rules for electronic claims 
generation. The actual transmission of claims is done by Revenue Management. If you make 
changes on these tabs in Medisoft, the changes flow automatically to Revenue Management, and 
changes made there are also transferred to Medisoft.

When sending electronic claims, set up your clearinghouse or direct payers in Revenue 
Management. Once an EDI receiver is set up, Revenue Management will synchronize the EDI 
settings in Medisoft. For users upgrading to Medisoft 21, Revenue Management can use the 
existing settings for the payors set up on the EDI Receiver screen, but you will need to reconfigure 
receivers to work with Revenue Management.

Figure 47.  EDI Receiver screen
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Set up your providers (physicians) in Medisoft so you can add them to patient records and 
transactions entered. In this way their information will be put on claims.   

Entering Provider Information

Enter provider records on the Providers screen. To do so:

1. On the Lists menu, point to Provider and click Providers. The Provider List screen appears. 
This screen shows you all of the providers currently set up in the practice.

Figure 48.  Provider List screen
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2. Click the New button. 

Figure 49.  Provider screen

3. On the Address tab, enter demographic information for the provider such as last name, first 
name, title. 

4. Options:

Select the Medicare Participating check box if the provider is considered a Medicare 
participating provider. A Medicare participating provider agrees to accept assignment on all 
Medicare claims for covered services and supplies. This field is generally used with electronic 
claims.

Select the Signature on File check box to indicate that the provider's signature is on file. Select 
this box if the provider has signed an agreement with Medicare to accept its charges and an 
affidavit is on file. If it is checked, the Signature Date field becomes active to display the date 
on which the signature was placed on file. Enter a date in this field.  

5. In the License Number field, enter the provider's license number.

6. Click the Save button if you are finished with the record or click the Reference tab.

The Reference tab displays data and values before the data was converted to Medisoft 21 and 
moved to the Provider IDs grid to create rules for claim creation. The tab shows data from the 
Default Pins and Default Group IDs tabs, which were replaced with the Provider IDs tab. 

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This tab is mostly used for reference purpose only. You can update data on this tab for your 
reference purposes, but none of this data is pulled for claim generation. The only field that still 
impacts claims is Provider Class. 

Figure 50.  Provider screen - Reference tab

7. Assign a provider to a provider class by clicking the Provider Class list and selecting a class.  

NOTE: Provider classes are set up in the Provider Class screen.

When generating claims, you can use the provider class on the Practice IDs tab to limit a rule 
to a specific class of providers. 

8. Click the Save button if you are finished with the record or select the Provider IDs tab. 

Entering Provider IDs Rules
Use the Provider IDs tab to enter or edit key data associated with a provider (tax ID/social security 
number, NPI, taxonomy, legacy numbers). Set up at least one rule on the Provider IDs grid for each 
provider in your practice and associate this information to all insurance carriers or insurance 
classes and all facilities or a particular insurance carrier or an insurance class. 

For information on creating these rules, see “Creating Rules Overview” on page 26.

To enter rules for a provider:
1. Select the Provider IDs tab.
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2. Click the New button to create a new rule. 

--OR--

To edit a rule, select the record on the grid and click the Edit button.

Figure 51.  New Provider ID screen

3. Select either All, Insurance Carrier, or Insurance Class. Select a carrier or class if 
necessary.

4. Select either All or Facility. Select a facility if necessary

5. Select either File Claim As Individual or File Claim As Group. 

6. Select either From Practice or National Provider ID. Enter an ID if the NPI is for this provider 
only.

If you do not want to send an NPI number on a claim, select From Practice and then on the 
Practice IDs screen, create a matching entry for the provider in which you select None for the 
NPI option.

7. Select the From Practice button to pull the NPI number from the Practice IDs grid.

WARNING: By selecting From Practice for the NPI, it will put the Practice NPI in the Rendering 
Provider in Loop 2310.

8. Select either From Practice or Taxonomy. 

If you do not want to send a taxonomy number on a claim, select From Practice and then on 
the Practice IDs screen, create a matching entry for the provider in which you select None for 
the Taxonomy option.
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
Select the From Practice button to pull the taxonomy number from the Practice IDs grid. 

9. Select From Practice, Tax Identifier, or Social Security Number. Select From Practice to pull 
the tax ID/social security number from the Practice ID grid.

10. If you file mammography claims, select Mammography Cert and enter the certificate number 
to associate with the rule.  

11. If you file laboratory claims using a CLIA number, select CLIA and enter the CLIA number to 
associate with the rule.   

12. If your carrier requires a care plan oversight number, select Care Plan Oversight, enter the 
care plan oversight number, and select an ID qualifier to associate with the rule. 

13. If needed, enter up to three legacy and qualifiers to associate with the rule using the Legacy 
Identifier 1, 2, and 3 fields. Use these fields to customize your rule to meet filing requirements 
with an insurance carrier(s).

14. Click the Save button.
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Many patient visits come to a practice as a result of a referral from another provider. When a 
patient is referred to your practice, create a record for the referring provider. Add data such as the 
Unique Physician Identification Number (UPIN), NPI, tax ID, and so on. In this record, you can link 
the provider to a particular insurance company/category, if needed. 

Entering Referring Provider Information

1. On the Lists menu, click Referring Providers. The Referring Provider List screen appears.

Figure 52.  Referring Provider List screen
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2. Click the New button.

--OR--

Select a record on the Referring Provider List screen and click the Edit button. 

Figure 53.  Referring Provider: (new) screen

3. On the Address tab, enter demographic information for the referring provider such as last 
name, first name, title. 

Also, if you are sending electronic claims, select from the Specialty list the referring provider’s 
special field of practice. If you need to use a specialty code that is different than the usual 
code, select "Not Listed" and enter your specialty code in the field that appears next to the 
Specialty list. 

NOTE: This field is not used for sending paper claims unless you have modified your claim form to 
include this information.
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Entering Referring Provider Rules

Use the Referring Provider IDs tab and grid to enter or edit key data elements associated with a 
referring provider (NPI, taxonomy, legacy numbers). You will set up at least one entry (rule) on the 
Referring Provider IDs grid for each referring provider that works with your practice and associate 
this information to all insurance carriers or insurance classes or a particular insurance carrier or an 
insurance class.  For more information on creating rules, see “Creating Rules Overview” on page 
26.

1. Select the Referring Provider IDs tab. 

Figure 54.  Provider screen - Provider IDs tab
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2. Click the New button to create a new grid entry. 

--OR--

Select an entry on the grid and click the Edit button. 

Figure 55.  New Referring Provider ID screen

3. Select either All, Insurance Carrier, or Insurance Class. 

4. Select either Entity Type: Person or Entity Type: Non-Person. 

5. Select either None or National Provider ID. 

6. Select either None or Taxonomy. 

7. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using the 
Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet filing 
requirements with an insurance carrier(s).

8. Click the Save button.
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Set up the insurance carrier records completely to ensure that your claims are processed in a 
timely manner. You can create insurance classes, into which you can group carriers based on a 
common feature. In addition, create your carrier records. 

Insurance Classes

Use this screen to create insurance classes, such as Blue Shield or Medicare. Use these classes 
to group insurance carriers for easier reporting and payment posting. 

To create insurance classes:
1. On the Lists menu, point to Insurance and click Classes. The Insurance Class List screen 

appears.  

Figure 56.  Insurance Class List screen

2. Click the New button.  
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3. Enter an ID, Name, and Description for the class.  

Figure 57.  Insurance Class screen

4. Click the Save button.
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Insurance Carriers

1. On the Lists menu, point to Insurance and click Carriers. The Insurance Carrier List screen 
appears. 

Figure 58.  Insurance Carrier List screen

2. Click the New button.

--OR--

Select an entry on the Insurance Carrier List and click the Edit button. 

Figure 59.  Insurance Carrier screen

3. Enter the carrier's information.  

4. From the Class list, select an insurance class to assign to the carrier.  
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5. Select the Options and Codes tab. 

Figure 60.  Insurance Carrier screen - Options and Codes tab

6. From the Procedure Code and Diagnosis Code Set lists, select a procedure code set (1, 2, or 
3) and a diagnosis code set (1, 2, or 3) to apply to the insurance carrier. Medisoft gives you the 
ability to assign up to three codes to the same procedure. By using this field, the claims for 
each carrier can contain the correct code.  

7. From the Patient, Insured, or Physician Signature on File lists, for each option select, Leave 
blank, Signature on file, or Print name.
These fields control what is printed in the signature Boxes 12, 13, and 31, respectively, on the 
CMS - 1500 claim form, if you are printing claims. These fields do not control whether anything 
is printed in these boxes, but what is printed. Whether anything prints is controlled by settings 
on the Case screen, Policy tab, Accept Assignment and Benefits Assigned field, and Provider 
screen, Address tab, Signature on File field. 
The Signature on file option prints "Signature on File" (if the Signature on file field has been 
activated in the patient and provider records).
The Print name option prints the name of the patient, insured, or physician.
The Leave blank option prints nothing. 

8. From the Print PINs on Forms list select PIN Only or Leave Blank. When setting up Medicare 
and Medicaid carriers for printed claims, select PIN Only; otherwise, select Leave Blank.

9. From the Default Billing Method 1, 2, and 3 lists, select either Paper or Electronic for handling 
primary (1), secondary (2), and tertiary (3) claims. Select Paper if claims are to be printed; 
select Electronic if claims are to be transmitted electronically. 

10. In the Default Payment Application Codes box select default payment codes.
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11. Select the EDI/Eligibility tab. The EDI/Eligibility tab is used for electronic claims.  

Figure 61.  Insurance Carrier screen - EDI/Eligibility tab

12. In the Primary Receiver panel on the EDI Receiver list, select the EDI receiver you use when 
sending electronic claims for primary insurances. If you do not enter an EDI receiver in the EDI 
Receiver field, electronic claims will not be created or sent for this insurance company. 

13. In the Claims Payer ID field, enter the payer ID for the insurance carrier. Refer to the 
enrollment information you received from the carrier/clearinghouse and look up the 
commercial identification number/ submitter identification numbers assigned to the insurance 
company by the clearinghouse.
If you use the eligibility verification service and want to verify eligibility with this insurance 
carrier, in the Eligibility Payer ID field, enter the payer ID (for some carriers, the eligibility payer 
ID is different from the payer ID). Refer to the enrollment information you received from the 
clearinghouse and look up the commercial identification number/ submitter identification 
numbers assigned to the insurance company by the clearinghouse.
From the Type list select a type for the insurance company.

14. Leave Alternate Carrier ID blank. Revenue Management will populate this field if needed.

15. If needed, select from the EDI Max Transactions list, a maximum number of transactions 
accepted by the carrier. This field is available for those carriers that limit the number of 
transactions per claim accepted electronically. If you submit more than the maximum number 
of transactions per claim, Medisoft automatically splits the claim.  

16. If the insurance carrier is used as both a primary EDI insurer and a Medigap insurer, in the EDI 
Extra 1/Medigap field, enter the Medigap number. The number entered is the COBA Medigap 
claim-based identifier received from the national Coordination of Benefits Contractor (COBC). 

17. The EDI Extra 2 field is used by Revenue Management.

18. Select the Complimentary Crossover check box if you are filing complimentary crossover 
claims. Secondary insurance will not be sent in the claim file. However, Medisoft will mark the 
secondary as sent. If you are sending Medigap claims, do not select this box.



Medisoft 21 Service Pack 1
62  February 2017

Insurance Carriers Chapter 8 - Insurance Classes and Insurance Carriers

19. Select the Delay Secondary Billing check box, if there is a secondary insurance company and 
you want to delay printing the secondary claim form until a response is recorded from the 
primary carrier. To print the secondary claim form at the same time the primary is printed, 
leave the box empty.

20. Select the Send Ordering Provider in Loop 2420E check box to send ordering provider 
information on an electronic claim.

21. Select the Send Practice Taxonomy in Loop 2000A check box to send taxonomy in Loop 
2000A for electronic claims. Loop 2000A is usually used to report taxonomy for individual 
providers. Contact your carrier for more information on their taxonomy requirements. 

22. Select the Allowed tab. This displays the amount last paid by the selected carrier for each 
procedure code available in Medisoft. If you do not enter anything in this table, each time a 
carrier makes a payment on a particular procedure code, Medisoft takes the amount paid plus 
any deductible and divides it by the established Service Classification percentage to arrive at 
the allowed amount. 

Figure 62.  Insurance Carrier screen - Allowed tab

This allowed amount is used when calculating the patient portion estimate of any procedure in 
the Transaction Entry screen. The existing allowed amount can be changed in the Transaction 
Entry screen by clicking the Allowed Amt column and entering the corrected amount.

23. Click the Save button.
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Setting ICD Version Utility

The Set ICD Version utility shows all existing insurance carriers and the current default diagnosis 
code set for each one. Select which carriers you want to change to ICD-10. 

When you are ready, click the Update Selected button to update your practice settings.

Figure 63.  Set ICD Version screen
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Setup Scenarios 

If you have a facility or a lab attached/affiliated with your practice, you will need to create a record 
for it. There are two components to the record: contact/demographic data entered on the Address 
tab and billing-specific information entered on the Facility IDs tab. 

A facility or lab is a location to which mail might be sent or calls directed, that has a separate 
address from your practice. 

Entering Facility Information

1. Click Lists and click Facilities.  The Facility List screen appears. 

Figure 64.  Facility List screen
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2. Click the New button.

--OR--

Select a record on the Facility List and click the Edit button.

Figure 65.  Facility screen, Address tab

3. Enter contact data associated with the facility, including a name, address, telephone number.

4. If the facility is a lab, click the Laboratory button; if the facility is not, click Facility.

Entering Facility IDs Rules

Use the Facility IDs tab to enter or edit key data specific to the facility (NPI number, taxonomy 
number, CLIA number, legacy numbers). If your practice is associated with a facility or a lab, set up 
at least one rule on the Facility IDs screen and associate this information to a specific insurance 
carrier or an insurance class. 

If you have entered a separate NPI number for your facility and need to send facility billing 
information for box 32 of the CMS 1500 form, specify the type of facility and qualifier along with the 
facility NPI number. If you need to send it on claims, select the Send Facility on Claim check box.

For more information on creating rules, see “Creating Rules Overview” on page 26.
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1. Select the Facility IDs tab. The Facility screen appears.

Figure 66.  Facility screen

2. Click the New button to create a new rule. 

--OR--

Select the record on the grid and click the Edit button. 

Figure 67.  New Facility ID screen

3. Select either All, Insurance Carrier, or Insurance Class. 

To apply the rule to a specific insurance carrier, select the Insurance Carrier button and click 
the magnifying glass to select the insurance carrier. 

To apply the rule to a specific insurance class, select Insurance Class and click the 
magnifying glass to select the insurance class. 

4. To include facility information on a print or electronic claim, select the Send Facility on Claim 
box and select an ID Qualifier.   
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5. Select either None or National Provider ID. Select National Provider ID and enter an NPI 
number to associate the facility NPI number with the rule.  

6. Select either None or Taxonomy. 

7. Select either None or CLIA.  

8. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using the 
Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet filing 
requirements with an insurance carrier(s).

9. Click the Save button.
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The Address file is your address book in Medisoft. It keeps the names, addresses, and phone 
numbers of important outside contacts, such as attorneys, employers, referral sources, and any 
other addresses you need.   

The Address file will include all important contact persons whose phone, fax, cell, and e-mail 
numbers the practice needs.  

The addresses maintained in Medisoft are classified by “type” assigned to help you select them in 
a drop-down list. These types include: Attorney, Employer, Miscellaneous, and Referral Source.  

To set up address records:
1. On the Lists menu, click Addresses. The Address List screen appears.

Figure 68.  Address List screen
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2. Click the New button on the Address List screen. The Address screen appears.

Figure 69.  Address screen

3. Enter a Code for a new address record or leave the field blank and let Medisoft create a unique 
code. 

4. Enter demographic data for the address.  

5. From the Type list, select Attorney, Employer, Miscellaneous, or Referral Source.

6. Enter other demographic data such as phone numbers and email address. 

7. Click the Save button.
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In this chapter you will learn about entering procedure and diagnosis codes that are used when 
you enter charges for your patients. 

Procedure, Payment, and Adjustment Codes

Procedure codes are used to communicate procedure information between patient, provider, and 
third-party payers.   

The Procedure/Payment/Adjustment List screen shows what codes have been set up.

Figure 70.  Procedure/Payment/Adjustment List screen

At the top of the screen, there are two fields to help you find a procedure code:  Search for and 
Field. Field defaults to Type but you can change it to Code 1 or Description. If you are not sure of 
the complete code, description, or type, enter the first few letters or numbers in the Search for 
field. As you type, the list automatically filters to display records that match.
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General Tab
Enter a new code number, description, and type in the General tab.  

Figure 71.  Procedure/Payment/Adjustment screen

Amounts Tab
The Amounts tab links to the Price Code field on the Account tab of the Case screen.  Medisoft 
Advanced and Medisoft Network Professional allow 26 charge amounts for each code entered in 



Medisoft 21 Service Pack 1
February 2017  73

Chapter 11 - Procedure, Payment, Adjustment, and Diagnosis Codes Allowed Amounts Tab (Advanced and Medisoft Network 

Medisoft. The applicable charge amount is selected in the Account tab of each patient’s Case 
screen. 

Figure 72.  Procedure/Payment/Adjustment screen - Amounts tab

Allowed Amounts Tab (Advanced and Medisoft Network 
Professional)

The Allowed Amounts tab keeps track of how much each insurance carrier pays for a particular 
procedure. Medisoft calculates the allowed amount based on the amount paid, any applicable 
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deductible, and the service classification.  This amount is used in calculating the patient portion of 
any transaction entered in Transaction Entry.  

Figure 73.  Procedure/Payment/Adjustments screen - Allowed Amounts tab
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MultiLink Codes

MultiLink Codes are groups of procedure codes combined as a single code. They are for 
procedures that are normally performed at the same time, for example, for a physical exam or a 
routine set of treatments.

There are two advantages to using MultiLinks:

 • You reduce data entry time by creating several transactions at once with a single code.

 • You reduce omission errors since you’ve already included all applicable codes in your 
MultiLink code. 

To create MultiLink codes:
1. On the Lists menu, click MultiLink Codes. The MultiLink List screen appears.

Figure 74.  MultiLink List screen
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2. Click the New button. The MultiLink Code screen appears.

Figure 75.  MultiLink Code screen

3. Enter a Code and Description for the procedure.

4. Select the procedures for this code from the Link Code fields. 

5. Click the Save button. 
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Diagnosis Codes

Diagnosis codes describe the medical reason(s) a service is provided. The procedure code tells 
what the physician did and the diagnosis code tells what the physician found.  

To create a new diagnosis code:
1. On the Lists menu, click Diagnosis Codes. The Diagnosis List screen appears.

Figure 76.  Diagnosis List screen

2. Click the New button. The Diagnosis screen appears. 

Figure 77.  Diagnosis screen
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3. Enter the correct Code and a Description. 

4. If necessary, enter values for ICD-9 and ICD-10 and their descriptions. You can use these for 
entering codes for different carriers but for the same diagnosis.  

5. Click the Save button.

Create ICD-10 Mappings
Use this utility to create new ICD-10 codes to map to existing ICD-9 codes or to map existing ICD-
10 codes to existing ICD-9 codes. To open this screen, on the Tools menu, point to Services, and 
click Create ICD-10 Mappings.

Figure 78.  Create ICD-10 Mappings screen - 1:1 Mappings tab
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A billing code is a user-defined two-character alphanumeric code used in sorting and grouping 
patient records for billing purposes. A billing code range is a filter available in most reports printed 
in Medisoft as well.

To enter a billing code:
1. On the Lists menu, click Billing Codes. The Billing Code List screen appears.

Figure 79.  Billing Code List screen

2. Click the New button. The Billing Code screen appears. 

Figure 80.  Billing Code screen

3. Enter a Code and Description. 

4. Click the Save button.
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NOTE: This is a Medisoft Advanced and Medisoft Network Professional feature. 

The Contact List is available to track people with whom you have had contact during the course of 
business. On the Contact screen, you can add notes regarding your conversations with the contact 
to help you keep track of what was discussed and any conclusions or information shared during 
the conversation.  

To add a contact:
1. On the Lists menu, click Contact List.The Contact List screen appears. 

Figure 81.  Contact List screen
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2. Click the New button. The Contact screen appears.

Figure 82.  Contact screen

3. Select the Category for the new contact. 

4. Enter information as necessary to complete your record.

5. Click the Save button.
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One of the most important functions in getting your practice set up is entering patient 
data. Complete patient information is important for filing claims and processing statements to bill 
your patients. 

Chart Number Considerations

Every patient or guarantor must have a chart number and be set up in the database before you can 
enter transactions for the patient. You can choose to allow Medisoft to create your patients’ chart 
numbers as you enter their records or you can use your own system. 

 • If you want Medisoft to create your chart numbers, simply leave that field blank when you 
create a patient record. 

 • If you want to use your own system, complete the Chart field as you enter the new patient’s 
information.   

If you want to use numeric chart numbers only, open Program Options, select the Data Entry tab, 
and select the Use numeric chart numbers check box.  

There is no need for corresponding numbers within a family; the number sequence has little 
bearing on grouping of patients. Each patient is set up individually in Medisoft and individual bills 
are prepared for each guarantor.

Once assigned, the Chart Number cannot be changed. To correct a wrong chart number, you must 
delete the entire patient record and create a new one with the proper chart number.  

All other data in the patient record can be modified.
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Entering Patient Information

1. On the Lists menu, click Patients/Guarantors and Cases. The Patient List screen appears.

Figure 83.  Patient List screen



Medisoft 21 Service Pack 1
February 2017  85

Chapter 14 - Patients Entering Patient Information

2. Click New Patient. The Patient/Guarantor screen appears.

Figure 84.  Patient/Guarantor screen

3. On the Name, Address tab, enter all known or necessary information.

Tip: In Medisoft Advanced and Medisoft Network Professional, you can establish default 
information, applied to all new patient records. Enter the information that is the same for all of your 
patients, and then click Set Default. To remove your new default settings, hold down CTRL and the 
button name changes to Remove Default.

When you enter a Social Security number, Medisoft checks through the patient records for any 
duplications. If a number you enter is a duplicate, Medisoft displays the name and chart 
number of the patient having that Social Security Number.

4. Select the Other Information tab. 
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5. Complete the fields here.  

Figure 85.  Patient/Guarantor screen - Other Information tab

If the patient’s employer record has been set up in the Address file (see “Attorney, Employer, or 
Other Addresses ” on page 69), select it on the Employer field. 

If you want to create a new address record, place the cursor in the Employer field and press F8. 
The Addresses screen will appear.
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6. Select the Payment Plan tab. Select a Payment Code to set up the payment terms for the 
patient.

Figure 86.  Patient/Guarantor screen - Payment Plan tab
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Transactions in Medisoft are generally case-based.  A case is a grouping of procedures or 
transactions generally sharing a common treatment, facility, or insurance carrier. You can set up as 
many new cases as needed for your patients, depending on changes to their insurance, treatment, 
diagnosis, and so on. For instance, you are treating a diabetic patient regularly and he is injured on 
the job. His visits regarding the work-related injury should be kept in a Workers’ Compensation 
case, totally separate from regular visits, for legal and reporting reasons. Ideally, you would have a 
case for each different malady from which the patient suffers. Then, you can pull up groupings of 
case visits to help you evaluate the patient’s overall health status.  By pulling a case that contains 
all diabetic treatments, one for high blood pressure, one for angina, and one for cancer, you get a 
better picture of the full range of health problems.  

TIP: If a patient comes for a one-time treatment, you can create a transaction for that treatment 
without creating an entirely new case. Just select different diagnosis codes in Transaction Entry 
when creating the transaction.

Creating a Case

To create a new case for a patient:
1. On the Lists menu, click Patients/Guarantors and Cases. The Patient List screen appears.

2. In the top right of the screen, click Case. The buttons on the Patient screen change.

Figure 87.  Patient screen with Case selected
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3. Click the New Case button. The Case screen appears. 

Figure 88.  Case screen - Personal tab

Medisoft will pull information from the patient’s record into the case record automatically. 

4. Complete the fields on each tab as is applicable for the new case. Be as complete as you can, 
since much of this information will be sent when you file claims. 

Tab Description

Personal Use this to enter general information on the new case and 
employer information.

Account Use this to enter the provider, referral, and attorney 
information set up in the Address file. Also enter billing and 
price codes and information on visit authorization, including 
the number of visits.

Diagnosis Use this to enter diagnosis codes for this case.
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5. Click the Save button.

Condition Use this to enter information pertinent to the illness, 
pregnancy, or injury, and tracking of symptoms. Also enter 
dates relative to the condition, plus Workers’ Compensation 
information.

Miscellaneous Use this to enter supplemental information such as lab work 
charges, whether the lab is in-house or outside, Referral and 
Prescription Dates, Local Use A and Local Use B fields, case 
Indicator code, and prior authorization. 

Policy 1, 2, 3 Use this to enter up to three insurance carriers for the patient, 
including policy and group numbers, and Insurance Coverage 
Percents by Service Classification (how much the carrier 
pays for certain types of procedures). The service percentage 
classification is tied to each procedure code.  

A Deductible Met check box is provided in the Policy 1 tab.  
When the patient meets his or her deductible obligation for 
the year, select this check box and the status is displayed in 
the patient account detail of the Transaction Entry screen.  

The three tabs have the same layout, except Policy 1 has 
fields for Capitated Plan and Co-Pay Amount and has the 
Deductible Met check box; Policy 2 has a field for Crossover 
Plan; and Policy 3 can be set up for tertiary or third-party 
involvement.

Medicaid and 
TRICARE

Use this to enter all submission numbers, reference, and data 
for each carrier. Also, enter branch of service information. 
Within the Medicaid and Tricare tab are EPSDT and Family 
Planning indicators, required submission numbers, and 
reference data for the case.  It also includes service 
information for TRICARE claims.

Multimedia tab 
(Network Professional 
only

Use this to ddd bitmaps to your patient records.

Comment (Advanced 
and Medisoft Network 
Professional)

Use this to enter notes to be printed on statements.

EDI Use this to enter information for electronic claims specific to 
this case.

Tab Description



Medisoft 21 Service Pack 1
92  February 2017

Copying a Case Chapter 15 - Cases

Copying a Case

In Medisoft, you can copy an entire case to help save you time. To do so

1. On the Lists menu, click Patient/Guarantor and Case. The Patient List screen appears.

2. Highlight the patient whose case you want to copy. The existing cases for that patient appear 
in the right pane of the Patient screen.

3. Highlight the case you want to copy. 

Figure 89.  Patient List screen with case selected

4. Click the Copy Case button.
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5. The Case screen appears with the data copied.

Figure 90.  Case screen

6. Modify the case data for the new case.

7. Click the Save button.
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Customizing the Case screen

In Medisoft Advanced and Medisoft Network Professional, you can customize the display of the 
tabs. If you do not need a tab, you can hide it. 

1. With the Case screen open, right-click on any tab header. A list of the tabs appears. A check 
mark appears next to the tabs that are currently displayed .

Figure 91.  Case screen with tab list displayed

2. Click one of the tabs to deselect it. The tab is now hidden.

3. To display the tab again, right-click any tab header.

4. Click the hidden tab to place the check mark on it. The tab appears again.
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Use the Transaction Entry screen to enter charges for procedures performed on patients. You can 
also enter co-payments here or adjustments to the patient’s bill. When you open the screen and 
select a Chart (patient) and case number, Medisoft automatically collects information from the 
patient and case records and displays it in the screen. The top right section of the screen shows 
you the patient’s balance, insurance information, and aging.

Medisoft is an Open Item Accounting program, meaning that transactions entered are marked 
when paid but remain on the active ledger as long as the case is active. There is no clearing of the 
ledger and bringing up a total to start a new month, as with a balance forward program.  

To open Transaction Entry:
1. On the Activities menu, click Enter Transactions. The Transaction Entry screen appears.

Figure 92.  Transaction Entry screen
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2. Select or enter a Chart (patient). The screen fills with patient information, including a Case 
number.

Figure 93.  Transaction Entry screen with patient selected

You can choose a default for the case number that appears on the Data Entry tab in Program 
Options. 

3. If necessary, change the case number.

4. To add a new charge, click the New button in the Charges section of the screen.

5. Select a Procedure and complete the remainder of the fields on the new charge line. Some of 
the information will be filled in automatically. 

6. Enter further charge lines as necessary.

7. If you need to enter a patient’s co-payment or other payments/adjustments, click the New 
button in the Payments, Adjustments, and Comments section of the screen.
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8. Select a Pay/Adj Code and complete the line. 

Figure 94.  Transaction Entry screen with payment

9. To apply this payment to a charge, click the Apply button. The Apply Payment to Charges 
screen appears. 

Figure 95.  Apply Payment to Charges screen

10. Click in the This Payment check box and enter the amount to be applied. 

Option: Use the Apply to CoPay or Apply to Oldest buttons to automatically apply the payment.

11. Click the Close button. Note that the Unapplied amount on the payment line changes. 

WARNING: e-MDs recommends that you apply all payments and adjustments to charges.  Failure 
to do so results in other parts of Medisoft not functioning properly, i.e., remainder billing and the 
delay secondary billing feature (Advanced and Medisoft Network Professional), to name only two. 
In addition, some report results will be incomplete or inaccurate.
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12. Click the Tax button if you need to add sales tax to the charges.

13. Click the Note button if you need to add further detail for a charge line. This may include detail 
for claims. 

14. Click the Save Transactions button.
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Unprocessed Transactions 

The Unprocessed Charges screen provides an interface between an Electronic Medical Records 
(EMR) service and Medisoft via McKesson Practice Interface Center (see “McKesson Practice 
Interface Center (MPIC)” on page 199) or a mobile device (Medisoft Network Professional only). 
Transactions that come from the EMR appear here in an unposted state. As long as they are 
unposted, they will not be part of patient accounts and you cannot file claims on them or bill 
patients for them. 

To open this screen:
1. On the Activities menu, point to Unprocessed Transactions and click Unprocessed EMR 

Charges. The Unprocessed Charges screen appears with a list of transactions that have yet 
to be posted.

Figure 96.  Unprocessed Charges screen

If there is a red or yellow x in the Transaction Status column for a line, click the Edit button to 
open the details and see the problem with the transaction. A red x indicates an error with the 
transaction that will likely cause it to fail claim scrubbing. A yellow x indicates a warning, such 
as a mismatch in an ICD code set version. 

Any notes associated with a transaction, usually coming from a mobile device, will appear as 
an icon in the unlabeled column. 

2. Select the check boxes in the Post column for the transactions you want to post.

3. Click the Post buton to update your patients’ accounts. 
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In this chapter you will learn about the Quick Ledger and Quick Balance features in Medisoft. 

Quick Ledger

NOTE: This is an Advanced and Medisoft Network Professional feature.

The Quick Ledger gives a quick reference for transaction and other information in the patient’s 
account. There are two types of Quick Ledgers in Medisoft: the Patient Ledger and the Guarantor 
Ledger.  

The Patient/Quick Ledger displays transaction information and account totals for individual 
patients. The Patient Ledger is the default ledger.

Figure 97.  Quick Ledger screen

To open the Patient Ledger:
 • On the Activities menu, click Patient Ledger.
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The Guarantor Ledger provides the same information as the Patient Ledger but allows you to view 
guarantor totals as well. 

Figure 98.  Guarantor Ledger screen

To get quick and easy access to a patient’s ledger from almost anywhere in Medisoft, press F7 or 
click the Quick Ledger speed button.  

To open the Guarantor Ledger:
 • On the Activities menu, click Guarantor Ledger.

While no new transactions can be made in the ledger itself, you can edit and print the ledger and 
gain valuable detail on patient accounts.

You can change responsibility for a selected transaction in the Quick Ledger screen. Right-click a 
transaction to change its responsibility between insurance carriers or from an insurance to the 
patient. This feature lets you skip entering the zero-dollar insurance payment to indicate that no 
payment is coming from the insurance carrier. 

Click the Edit button or press F9 to open the Transaction Entry screen where charges, payments, 
and adjustments can be reviewed and edited, as needed. Both the Patient and the Guarantor 
Ledgers let you view the notes entered for transactions and also add a note. 
Click the Payment Detail button to display all payments/adjustments made toward a specific 
charge. 

TIP: If you click the Quick Statement button, you will print statements from the Reports menu. If 
you click Statement, you will print statements from Statement Management.  For more information 
in creating and printing statements, see “Creating Statements” on page 115.
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Quick Balance 

NOTE: This is an Advanced and Medisoft Network Professional feature.

The Quick Balance is a summary of all remainder charge totals for a selected guarantor record.  

To open the Quick Balance screen:
 • On the Activities menu, click Quick Balance. 

Figure 99.  Quick Balance screen

If the record selected is a guarantor’s record, the Quick Balance screen displays each patient for 
whom the guarantor is responsible and the total qualifying remainder charges for each. If the 
record selected is not a guarantor’s record, you will see a listing of all the selected patient’s 
balances. 

TIP: If you click the Print button in Quick Balance, you will print statements from the Reports 
menu. For more information in creating and printing statements, see “Creating Statements” on 
page 115.
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In the chapter you will learn how to create claims in Medisoft. 

Claim Management

This section explains briefly how to manage claims in Medisoft and includes creating, editing, 
printing/reprinting, and listing claims, as well as changing claim status. 

The Claim Manager’s Job 
To help you better understand the function of claim management, consider this shipping analogy.  
Whereas Cases are containers filled with claims for specific diagnoses, claim management is the 
process by which the cases are checked, sorted, and delivered. In other words, claim management 
is the process of making sure all shipments are correct, ready to be sent, and shipped to the right 
companies (insurance carriers).  

The Claim Manager (the person performing claim management) checks the claims, makes sure 
the boxes are properly marked, and sends them on their way. The Claim Manager determines 
whether the shipment goes by truck (paper claims) or by air (electronic claims). When a box is 
returned (rejected claim), the Claim Manager makes whatever changes are necessary (with help 
from the EOB [see “Encoder Pro” on page 199] or Audit/Edit Report) and ships the box again 
(resubmits the claim).

One person sees and treats the patients; another person enters data from the superbill (see 
“Superbill” on page 200) to begin the billing process. Once all the data has been entered, it must 
go through the Claim Manager’s office before being sent to an insurance carrier.

The Claim Manager focuses on three principal areas, not necessarily sequential:  review, batch, 
and final review.

 • Watchdog:  The Claim Manager is, first of all, the watchdog of the claims. The Claim Manager 
checks each claim and verifies the numbers, having the authority to edit the claim and make 
needed changes. If there is something in the claim that should go to a different carrier than 
indicated, or if the EDI receiver information is incomplete, the Claim Manager corrects the 
record. The Claim Manager also has access to the insurance carrier records and checks the 
billing date and how the claim is to be sent, either by paper or electronically. Then, the Claim 
Manager can indicate the status of the claim.  

 • Batch ‘em up!  The function of creating claims serves to group claims that are headed to the 
same destination. The Claim Manager gathers and sorts by range of dates or chart 
numbers. Transactions can be selected that match by primary carrier, Billing Code, case 
indicator, or location. Random Billing Code numbers can be selected. The Claim Manager can 
also indicate a minimum dollar amount for creating the claims, eliminating claims too small to 
be worth billing.
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 • Reviewer:  There is also a List Only button that allows the Claim Manager to retrieve claims 
that match certain criteria that have been determined. The List Only Claims That Match 
screen is a “show me” screen that lets the Claim Manager review all that is in Medisoft.  

Besides these three focus areas, the Claim Manager also has responsibility to mark claims that are 
paid and those that are rejected.

 • Marking paid claims: The date of submission in the Claim Management screen indicates when 
the claims were shipped or transmitted. Claims are marked under the designation of “Sent” 
and the date is automatically inserted. The claims stay in Claim Management marked as 
“Sent” until they are manually changed in the Claim edit screen as having been received and 
dispatched by the carrier. When a payment is received, use the EOB to enter all payments 
through transaction entry. 

 • Handling rejected claims:  When a paper claim is rejected for payment by the insurance 
carrier, the Claim Manager can change the payment status in the Claim Management screen 
from “Sent” to “Rejected.”   

Creating Claims
To perform claim management functions, use the Claim Management screen. Here is where you 
create, edit, and print claims. Claims that will be sent electronically are created here but sent with 
Revenue Management, an integrated application that will send claims and receive payments. For 
more information on Revenue Management, see “Electronic Claims Processing” on page 139.

To create claims:
1. On the Activities menu, click Claim Management. The Claim Management screen appears.

Figure 100.  Claim Management screen
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2. Click the Create Claims button. The Create Claims screen appears.

Figure 101.  Create Claims screen

3. Use the fields on this screen to filter the ranges of dates, chart numbers, insurance carriers, 
and so on. 

4. Click the Create button. The Claim Management screen appears and displays the claims that 
were created.

Figure 102.  Claim Management screen with new claims   



Medisoft 21 Service Pack 1
108  February 2017

Editing Claims Chapter 18 - Creating Claims

Editing Claims
If a claim is rejected by the carrier, you will have to edit it so that it contains all of the information 
that the carrier wants. 

To edit a claim:
1. On the Activities menu, click Claim Management. The Claim Management screen appears. 

2. Highlight the claim you want to edit and click the Edit button. The Claim screen appears with 
the claim detail.

Figure 103.  Claim screen

The Claim screen has several tabs that contain the information for the claim. 

Tab Description

Carrier 1, 2, 3 Use this tab to change the Claim Status, Billing Method, and the 
insurance carrier or EDI Receiver.

Transactions Use this tab to see all of the transactions that are part of the 
selected claim. You can split, add, or remove transactions here.

Comment Use this tab to place whatever comments you feel are necessary 
concerning this claim and/or any transactions relating to it. If you 
have Medisoft Advanced or Medisoft Network Professional, 
these notes will appear as a note icon in the Claim Management 
screen.

EDI Note Use this tab to add information for EDI notes.
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3. Revise the information on the tabs as necessary. 

4. Click the Save button. 

Printing Claims
If you print and send paper claims to clearinghouses and carriers, use the printing feature on the 
Claims Management screen.

1. On the Activities menu, click Claim Management. The Claim Management screen appears.

2. Click the Print/Send button. The Print/Send Claims screen appears.

Figure 104.  Print/Send Claims screen

3. Select Paper and click the OK button. The Open Report screen appears.

Figure 105.  Open Report screen
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4. Select which form you want to print on and click the OK button. The Print Report Where? 
screen appears.

Figure 106.  Print Report Where? screen

5. Select your option and click the Start button. The Data Selection Questions screen appears.

Figure 107.  Data Selection Questions screen

6. Make your selections for the various ranges and click the OK button. 

7. The Status of the claims will be updated to Sent on the Claim Management screen. 
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Figure 108.  Claim Management screen with Status of Sent
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Troubleshooting Insurance Claims

Claim Form Not Centered
If your insurance claims are printing off-center, you can fix this with the following steps:

1. On the Reports menu, click Design Custom Reports and Bills. The Medisoft Report 
Designer opens.

2. On the File menu of Medisoft Reports Designer, click Open. The Open Report screen 
appears.

Figure 109.  Open Report screen

3. Select the report form you use and click the OK button. The form opens.
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4. On the File menu, click Report Properties. The Report Properties screen appears.

Figure 110.  Report Properties screen

5. In the Form Offset section of the screen, adjust the form as necessary from the top and/or left 
margins. The form is moved in increments of one hundredth of an inch. 

6. Click the OK button.

7. Save the report and close Medisoft Reports Designer.

Reprinting Claims
You can reprint claims if there is a problem with some of those that printed. To do so, follow the 
steps above on printing claims, except select Reprint Claim instead of Print/Send. See “Printing 
Claims” on page 109.

Changing Claim Status
In the Claim Management screen, all submitted claims are automatically marked Sent with an 
indication of the method of submission. There may be occasions when you need to change this 
status, for instance, if you need to resend them from Revenue Management. 

Entire Batch
If the status of an entire batch needs to be changed, you can change all the claims at once.  
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1. Highlight one of the claims on the Claim Management screen and note the number listed in 
the Batch 1 column.  

2. Click Change Status. The Change Claim Status/Billing Method screen appears.  

Figure 111.  Change Claim Status/Billing Method screen

3. Select Batch and enter the batch number from the Batch 1 column in the Claim Management 
screen.  

4. Choose the appropriate buttons in the Status From and Status To sections.  

5. Click the OK button.   

Selecting Multiple Claims
1. When only one or a few claims within the same batch or claims from multiple batches need a 

status change, on the Claim Management screen, hold down the CTRL key and click each 
claim that needs the status changed. Note that the selected claims do not need to have the 
same claim status, but they will all change to the same status when you complete this 
procedure.  

2. Click the Edit button. 

3. In the Change Claim Status/Billing Method screen, click Selected Claim(s)

4. Select the appropriate buttons in the Status From and Status To sections. 

5. If you have chosen claims with varying statuses, select Any status type in the Status From 
section.  

6. Click the OK button.  
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In this chapter you will learn how to create statements for billing your patients and updating them 
on charges to their accounts.

Statement Management 

NOTE: This is an Advanced and Medisoft Network Professional feature.

This section explains briefly how to manage statements within the Statement Management screen 
and includes creating, editing, printing/reprinting, and listing statements, as well as changing 
statement status.

You can use Statement Management to create, bill, and rebill statements all from one place.  You 
can also view information about the statement, such as the guarantor, the status, the initial billing 
date, and the type. You can also generate statements to track missed copays. 

Creating Statements
When you want to bill your patients, create statements. You can print your statements to paper or 
you can use BillFlash to send them electronically. BillFlash will print and send your statements to 
your patients for you. 

1. On the Activities menu, click Statement Management. The Statement Management screen 
appears. For more information on BillFlash, see “BillFlash Users” on page 44.

Figure 112.  Statement Management screen
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2. Click Create Statements.  

Figure 113.  Create Statements screen

3. Enter ranges of transaction dates and/or chart numbers to control which statements are 
created, as well as other data for filtering the data.  

4. Click the Create button. The system tells you how many statements were created. 

5. Click the OK button. The new statements appear on the Statement Management screen.
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Editing Statements
1. On the Statement Management screen, highlight a specific statement.

2. Click the Edit button. You can modify general statement information, the transactions that 
appear on the statement, and any comments attached to the statement. When you make 
changes in the Statement edit screen, you modify only that statement and do not affect the 
defaults for other statements. 

Figure 114.  Statement screen

The Statement screen has three tabs that contain the information for the claim. 

3. Revise the information on the tabs as necessary. 

4. Click the Save button. 

Printing Statements
If you print and send paper statements to your patients, use the printing feature on the Statement 
Management screen.

Tab Description

General Use this tab to change the Claim Status, Billing Method, and the 
billing date.

Transactions Use this tab to see all of the transactions that are part of the 
selected statement. You can split, add, or remove transactions 
here.

Comment Use this tab to place whatever comments you feel are necessary 
concerning this statement and/or any transactions relating to it. 
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1. On the Activities menu, click Statement Management. The Statement Management screen 
appears.

2. Click the Print/Send button. The Print/Send Statements screen appears.

Figure 115.  Print/Send Statements screen

3. Select Paper and click the OK button. The Open Report screen appears.

Figure 116.  Open Report screen
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4. Select which form you want to print and click the OK button. The Print Report Where? screen 
appears.

Figure 117.  Print Report Where? screen

5. Select your option and click the Start button. The Data Selection Questions screen appears.

Figure 118.  Data Selection Questions screen

6. Make your selections for the various ranges and click the OK button. 
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7. The Status of the claims will be updated to Sent on the Statement Management screen. 

Figure 119.  Statement Management screen with Status of Sent

Reprinting Statements
If necessary, you can reprint statements without regard to their status. To reprint an entire batch, 
the status must be changed for the batch.

Changing Statement Status
In the Statement Management screen, all submitted statements are automatically marked Sent 
with an indication of the method of submission. There may be occasions when you need to change 
this status.  

Statements sent electronically through BillFlash get a report that marks each statement as either 
accepted or rejected.  

Entire Batch
If you need to change the status of an entire batch, you can change all the statements at once. 

1. On the Statement Management screen, highlight one of the statements and note the number 
listed in the Batch column. 
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2. Click Change Status. The Change Statement Status/Billing Method screen appears. 

Figure 120.  Change Statement Status/Billing Method screen

3. Select the Batch button and enter the batch number from the Batch column in the Statement 
Management screen.  

4. Select the appropriate buttons in the Status From and Status To sections. 

5. Click the OK button.  

Selecting Multiple Statements
1. When only one or a few statements within the same batch or statements from multiple batches 

need a status change, on the Statement Management screen hold down the CTRL key and 
click each statement that needs the status changed. Note that the selected statements do not 
need to have the same status, but they will all be changed to the same status.  

2. Click the Edit button. The Change Statement Status/Billing Method screen appears.

3. Select Selected Statement(s).

4. Select the appropriate buttons in the Status From and Status To sections. 

5. If you have chosen statements with varying statuses, choose Any Status Type in the Status 
From section.  

6. Click the OK button.  

Billing Cycles
The cycle billing feature lets you print statements every certain number of days. If you want to print 
statements every 30 days, you can set up a billing cycle of that length.  

Follow these steps to set up a billing cycle:

1. On the File menu, click Program Options. The Program Options screen appears.
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2. Select the Billing tab.

3. Select the Use Cycle Billing check box.

Figure 121.  Program Options screen - Billing tab

4. Enter a number in Cycle Billing Days. The number of days indicates the length of your billing 
cycle. 

5. Click the Save button.

Now, after you click Print/Send on the Statement Management screen, Medisoft will automatically 
print statements based on the Next Statement Date of each statement. If the Next Statement Date 
is on or before the current date, the statement prints. If you have never printed statements with the 
billing cycle turned on, statements are printed according to the Last Statement Date stored in the 
statement record. If the Last Billing Date plus the billing cycle interval is on or before the current 
date, the statement prints. 

NOTE: Statements might not print if they are filtered out by report selection questions or by 
predefined statement processing rules.

The program updates the statement's Next Statement Date for the next time you process 
statements.
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Troubleshooting Statement Printing

Patient Remainder Statements 

NOTE: This is an Advanced and Medisoft Network Professional feature.

If you are having trouble printing patient remainder statements, check to be sure the following items 
have been performed:

 • The patient has insurance coverage. This is indicated in the patient Case screen, Policy 1 tab, 
Insurance 1 field (also Policy 2 and Policy 3 tabs if there is secondary and/or tertiary 
coverage).

 • A charge has been posted in the patient case.

 • A claim has been created.

 • An insurance payment or adjustment has been posted, applied, and marked as Complete to 
the account for each applicable carrier. 
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NOTE: Deposits/Payments is an Advanced and Medisoft Network Professional feature.

Although you can enter payments in transaction entry for patient copays, you can also enter 
payments using Deposit/Payment. This option makes creating a deposit list and applying 
payments, especially payments from insurance carriers, an easy process. The advantage to this 
option is that you can apply a payment toward several cases and charges from the same screen. 

Entering a Payment

To enter a payment:
1. On the Activities menu, click Enter Deposits/Payments. The Deposit List screen appears.  

Figure 122.  Deposit List screen
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2. Click the New button. The Deposit (new) screen appears.

Figure 123.  Deposit (new) screen

3. Select the appropriate Payor Type. Depending on your selection, the fields on the screen will 
change. 

4. Complete the remaining fields as necessary, specifying the insurance or patient who paid.

5. Click the Save button. The new payment appears on the Deposit List screen and is 
highlighted. It is now available to be applied to charges. 

Figure 124.  Deposit List screen with new payment highlighted
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Applying a Payment
1. On the Activities menu, click Enter Deposits/Payments. The Deposit List screen appears.

Figure 125.  Deposit List screen

TIP: To save time and increase work efficiency, you can close a case after applying payment by 
right-clicking the line item in the grid and then selecting Close Case.  

2. Highlight a payment and click the Apply button. The Apply Payment/Adjustments to Charges 
screen appears.

Figure 126.  Apply Payments/Adjustments to Charges screen

3. Select the patient chart number (if you have chosen an insurance payment)
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4. Apply the portion of the payment to the applicable charge(s). 

Figure 127.  Apply Payment/Adjustment to Charges screen

5. Click the Save Payments/Adjustments button.  

TIP: If you select the Print Statement Now check box and click the Save Payments/Adjustments 
button, you can print statements from Statement Management.

6. If you need to apply payments from the same deposit to another patient record, select the next 
patient chart number and continue making payment applications. 

This screen is also tied to the Payment Application tab of Program Options. Unless 
deactivated, all payment applications are automatically checked as paid in full by the payer, 
allowed amounts are calculated on all charges, and any charges over the calculated allowed 
amounts are automatically entered in the Adjustment field. You can open and change Program 
Options that are applicable to this screen by clicking Options in the bottom left of the screen

TIP: Be sure to click the Save Payments/Adjustments button before closing this screen or 
transactions cannot be created. 

7. Click the Close button.

EOB Payments

Part of the payment structure to a healthcare office from an insurance carrier involves a check and 
an Explanation of Benefits. Widely known throughout the industry as the EOB, it lists claims for 
which payment is being made and, in some cases, an explanation of what is not being paid and 
why.

Not every insurance claim that is filed with a carrier is paid in full. It may be that payment is 80 
percent of the claim or it may be 50 percent. Other times a claim may be totally or partially 
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disallowed. The EOB explains in these cases. Normally, the part that is not paid by the carrier is 
picked up by a secondary carrier or charged back to the patient.

When a payment is received, a transaction must be entered to offset the charges. This is done by 
creating a deposit in the Deposit List screen. If the payment covers several charges, distributing a 
payment to specific charges can be handled by clicking Apply.  Then, select the patient records 
and claims to be paid and designate how much goes to each.  

Managed Care

One of the important sources of patients and income in many practices are managed care 
organizations. An HMO or PPO provides a list of patients who have selected your practice as their 
primary care provider. Payment is made to your practice on a per-patient basis, regardless of 
whether the patient ever visits the office. When a patient does come in for treatment, he or she 
pays a set co-pay amount.

The co-pay is charged only by the primary care facility or the facility to which the patient is referred 
by the primary care facility. After a patient’s visit to the physician’s office, a claim is filed and sent to 
the carrier. When the EOB is returned, there is seldom a payment included, since payment is made 
under the capitation program for managed care organizations.   

Capitation Payment
The basis for capitation payments is to provide healthcare for a fixed cost, irrespective of the 
amount of service required by each individual patient. This is done in connection with the managed 
healthcare services such as HMOs and PPOs. There is no direct relationship between the 
capitation payment received by the practice and the number of patients covered by the plan who 
actually visit the practice for treatment. Capitation payments are not posted to patient accounts but 
are entered in the Deposit List screen.  If it is necessary to zero out a patient account, create a zero 
deposit for the carrier. For each patient covered by the capitation payment who has an outstanding 
balance, zero out the account by entering the remainder in the Adjustment field. When it is applied, 
the payment shows as zero and the patient’s balance shows as a write off in the Adjustment field in 
the Transaction Entry screen.
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ePayments

If you have enrolled with BillFlash and patients are making payments online directly to BillFlash, 
you can download these payments to your practice by clicking ePay on the Deposit List screen. 
Medisoft will capture these payments and display them in the Deposit List screen. Then, you can 
apply them to charges. 
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In this chapter you will learn about managing collections and writing off balances that you know will 
never be paid. 

Collection List

The Collection List is a central place where you can manage accounts that are in 
collections. Ticklers or collection reminders are displayed as collection list items.  

To open the Collection list: 
 • On the Activities menu, click Collection List. The Collection List screen appears.

You must activate Security and create user logins before this feature can be used. For more 
information on security, see “Security Setup Overview” on page 35.

Figure 128.  Collection List screen

What appears in the collection list depends on the user login. Medisoft displays the collection list 
item for the current user, unless the user has administrative access.  Administrators can choose to 
view all or selected users’ collection list items.  
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Adding a Tickler 
“Ticklers” are notes you enter for the Collection List that remind you to make efforts to collect on 
overdue patient accounts.

To create a new tickler: 
1. On the Collection List screen, click the New button. The Tickler Item screen appears.  

Figure 129.  Tickler Item screen

2. Complete the fields as necessary. 

3. Click the Save button. The new item is added to the Collection List. Once a tickler is created 
for this patient, you can create collection letters. 

Adding Collection List Items
Use this screen to create multiple ticklers at once, based on criteria you enter here. 
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1. On the Collection List screen, click the Add Items button. The Add Collection List Items 
screen appears.

Figure 130.  Add Collection List Items screen

2. Make your selections here from the various filters and options. Note that you can also assign 
these new ticklers to a specific user. 

3. Click the Add Items button. The new items appear on the Collection List. 
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Patient Payment Plans

To help patients make consistent payments on their accounts, you can create payment plans. You 
can create as many plans as necessary to accommodate your patients.

Creating a New Plan
1. On the Lists menu, click Patient Payment Plan. The Patient Payment Plan List screen 

appears. From here, you can see all of the existing payment plans. You can add a new plan, 
edit an existing plan, or delete a plan.

Figure 131.  Patient Payment Plan List screen

2. Click the New button. The Patient Payment Plan screen appears.

Figure 132.  Patient Payment Plan screen

3. Complete the fields for the new plan. 
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4. Click the Save button.

Applying a Plan to a Patient
Once you create a plan, add it to the patient’s record. 

1. On the Lists menu, click Patients/Guarantors and Cases. The Patient List screen appears.

2. Highlight the patient whose record you want to update and click Edit Patient.

3. Select the Payment Plan tab.

Figure 133.  Patient/Guarantor screen - Payment Plan tab

4. Select the appropriate code in the Payment Code field. The details of the plan appear on the 
tab.

5. Click the Save button.

Medisoft records and tracks the scheduled date for the next payment and the amount to be 
applied. If the patient follows the payment plan, their account will not be included when you 



Medisoft 21 Service Pack 1
136  February 2017

Collection Letters Chapter 21 - Managing Collections and Small Balance Write-Offs

process collection letters. If the patient does not follow the payment plan, their account will be 
included when you process collection letters.

Collection Letters

Once you put a patient-responsible account in collections, you can create collection letters to follow 
up with the patient.  

To print collection letters: 
1. On the Reports menu, point to Collection Reports, and click Patient Collection Letters. The 

Print Report Where? screen appears.

You must print the Collection Letter Report before you print collection letters. 

2. Select one of the options and click the Start button. The Data Selection Questions screen 
appears.

Figure 134.  Data Selection Questions screen

3. Make your selections for filtering data.

4. Select the Exclude items that follow Payment Plan check box to activate the Generate 
Collection Letters box.  

5. Select the Generate Collection Letters check box. 

6. Click the OK button.

7. Click the Yes button to the question “Do you want to print collection letters?” The Open Report 
screen appears.

8. Select the form and click the OK button. The Print Report Where? screen appears. 

9. Make your selection and click the Start button. 
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 Small Balance Write-off
This feature lets you automatically write off remainder balances of a certain amount. The balance 
written off is the patient remainder balance. You can write off small remainder balances as a batch 
in the Small Balance Write-off screen or for one patient at a time in the Apply Charges/Adjustments 
to Payments screen. 

Writing off a Balance
1. On the Activities menu, click Small Balances Write-off. The Small Balance Write-off screen 

appears.

Figure 135.  Small Balance Write-off screen

2. In the lefthand section of the screen, enter criteria for the type of remainder balances you want 
to write-off and click the Apply button. In the right hand section, a list of the patients who meet 
the criteria appears in the Write-off Preview List. The default is set to write off all records in the 
list. You can select individual records to write off by clicking on the record. Multiple records can 
be selected by pressing the CTRL key and clicking the record. 

3. Click Write off to write off the selected remainder balances.

Use the Stmt Submission Count + field to define a maximum amount of times that you want to 
send a statement before writing off the balance. Once this number is met, the small balance is 
written off. Medisoft selects patients whose statements have been sent (submission count) more 
than the value entered in the field. Once this number is met, the small balance is written off. This 
field works in conjunction with the other fields on this screen. If a value is entered in this field, the 
balance is only written off if it meets the criteria for this field (completed the statements) and the 
other fields such as Maximum Amount field. For instance, if you enter 3 in this field and 10 in the 
Maximum Amount field, small balances would be written off after three statements are sent and if 
the balance is under $10.00.

When Medisoft writes off the remainder balances, it updates a number of other areas of the 
database. Write-off entries are created and applied to all patient responsible charges associated 
with the selected patient. Medisoft also updates the associated Collection List items, refreshing 
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balances and marking zero balances as deleted. After a remainder balance write off, statements 
are changed to the status of Done and a note is added to the write-off entries.



Medisoft 21 Service Pack 1
February 2017   139

Chapter 22 - Using Electronic Services

This chapter gives a brief overview of the electronic services available in Medisoft.

Electronic Claims Processing

Electronic claims send your insurance claims online either directly to the insurance carrier or to a 
clearinghouse, which then sends the claims to the insurance carrier. Medisoft currently ships with 
Revenue Management, an integrated component that installed when you installed Medisoft. To 
launch Revenue Management

 • On the Activities menu, point to Revenue Management, and click Revenue Management.

Statement Processing

You can send statements electronically through BillFlash, the web-based company that is set up to 
process Medisoft electronic statements. Statements sent electronically through BillFlash get an 
instant response report that tells what information was sent. BillFlash will receive your statement 
data and then print and send statements to your patients. BillFlash can also receive payments from 
patients and you can download them to Medisoft and apply them to patient accounts. 

Eligibility Verification

The Eligibility Verification feature lets you check a patient's insurance coverage online. Revenue 
Management conducts eligibility verification behind the scenes.  

Eligibility Verification Setup
Before you can perform eligibility requests electronically, you must make sure certain information is 
in your practice records. Use the following table to help you verify your records are complete.

Field(s) to complete Screen or tab on which the field is 
located

Practice Tax ID Practice Information screen, Practice 
IDs rules

Tax ID Providers screen, Provider IDs tab (if this 
value is different from the Practice Tax 
ID above)
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 
You must also apply security to your practice and create at least one user. For more information on 
Medisoft security, see “Security Setup Overview” on page 35. 

Eligibility Verification Results
There are multiple places in Medisoft from which you can make eligibility verification requests: the 
Eligibility Verification Results screen, the Patient List screen, Office Hours, and the Task Scheduler 
screen. The type of eligibility inquiry you make, either real-time or scheduled, depends on the 
screen from which you are making the request.  

Eligibility Verification Results
If you access this screen from the Activities menu, it will automatically show the last inquiry made 
for each patient. You can also set it to show all inquiries. 

To make a real-time eligibility inquiry from the Eligibility Verification Results 
screen: 
 • Highlight the patient and click the Verify button.  

Claims Payer ID Insurance Carriers screen, EDI/Eligibility 
tab

Last Name, First Name, Date of Birth, 
Gender, Social Security Number

Patient/Guarantor screen, Name/
Address tab

Assigned Provider Patient/Guarantor screen, Other 
Information tab

Insurance, Policy Holder, Relationship 
to Insured, Policy Number.

Case screen, Policy tabs

Assigned Provider Case screen, Account tab

Field(s) to complete Screen or tab on which the field is 
located
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Patients

To make a real-time eligibility inquiry for a specific patient: 
1. Right-click the patient's case in the Patient List and click Eligibility Verification.

Figure 136.  Patient List with Eligibility Verification highlighted

2. The Eligibility Verification Results screen appears.  

3. Click the Verify button to make the inquiry.

TIP: Press F10 to launch the Eligibility Verification Results screen to verify a patient's eligibility. 

Task Scheduler
You can use the Scheduled Tasks feature to schedule a daily time to send a batch of eligibility 
inquiries. To schedule a batch, 

1. On the Activities menu, point to Eligibility Verification and click Schedule. The Medisoft Task 
Scheduler screen appears.

2. Click the New button. The Select Type screen appears.

3. Select Eligibility.

4. Click the OK button. The Select Practice screen appears.
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5. Select the practice and click the OK button. The New Eligibility Task screen appears.

Figure 137.  New Eligibility Task screen

6. Complete the options and click the Save button. The new task appears on the Medisoft Task 
Scheduler screen.

Figure 138.  Medisoft Task Scheduler screen

The task will automatically make inquiries for patients scheduled in the appointment grid up to a 
week in advance.  
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Medisoft Mobile

This feature is available only for Medisoft Network Professional.

Features
With your mobile device you can:

 • Perform Patient Intake: Have your patients use a mobile device to enter demographic 
information.

 • View Appointments: See a list of appointments by day or by the week. Tap an appointment to 
see details on the patient. You can also see multiple providers in a single view. However, you 
will be able to see a Day view only.

 • Enter Charges: Select a patient, facility, procedure and diagnosis codes, and submit charges 
for existing visits or new visits.

 • Update Superbill Templates: Tapping Setup will allow you to update the template you use for 
entering charges on your mobile device. You can create multiple templates and decide if the 
superbill should be viewed in Portrait or Landscape on your mobile device.

Security
eMDs’ Mobile Application utilizes HIPAA compliant data transmission safeguards, such as 
encryption and authentication for all Mobile Application connections and communication to secure 
and maintain confidentiality of data.

Installation
The installer installs all of the files, application services, and settings necessary to support the 
implementation of Medisoft Mobile in a client/server environment.  

Configuration
You must configure your mobile device before you can use it to link to your practice data. See the 
Medisoft installation guide for step-by-step information. 
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In this chapter you will learn about Office Hours and some of the basic features available for 
creating and managing patient appointments.

Office Hours Overview

Office Hours is an appointment scheduling program that helps keep track of appointments for your 
practice.  It is automatically installed with Medisoft.

Starting the Program

From the Windows Desktop
 • Click the Office Hours Professional icon on your computer desktop. 

From Within Medisoft
 • On the Activities menu, click Appointment Book.
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Office Hours Setup

There are several sections of the program that must be set up before you start scheduling.

1. First, set up provider records.  If you are booking appointments for lab work or therapy, each of 
those technicians will have a provider number and schedule and so will each office member 
whose schedule will be included in the Office Hours program.

2. Set up your patient records.  

3. Create your resource records. You can include all treatment apparatuses in this list, as well as 
consultation and treatment rooms, so that you do not double-book a room or equipment.

4. Set up program options, such as establishing appointment length, creating whatever views 
you need for viewing multiple columns at once, and deciding how much information you want 
displayed in your appointment blocks in the appointment grid.  

5. Set up breaks and recurring breaks, to show lunch hour, set coffee-type breaks, seminars, and 
so on.

6. Set up security.
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Using Office Hours

Entering a New Appointment

You can enter a new appointment on the Appointment Grid that opens when you start Office Hours. 
To create a new appointment

1. Select a provider in the provider field in the top right of the grid.

Figure 139.  Appointment Grid

2. Double-click the timeslot for which you want to enter an appointment. The New Appointment 
Entry screen appears. 

TIP: If you want to set up an appointment for someone who is not a patient and has no chart 
number, skip the Chart field and enter the person’s name in the Name field. Enter all other 
necessary information. You can also print the appointment list showing blank appointments and 
manually write in appointments. Also, If a patient’s case has an Authorized Number of Visits set on 
the Account tab of the Case screen, the program will warn you when the patient approaches the 
maximum number of authorized visits.

3. In the Chart field, type or select the patient’s chart number.  
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4. Select a value for the Resource field. 

5. Enter any notes about the appointment in the Note field. If you want to create a new line in the 
note, press CTRL + ENTER.

6. In the Case field the newest case entered for the patient appears. To change the case to which 
the appointment is tied, click the arrow to select the case. 

Tip: You can right-click the field to create a new case, edit the selected case, or copy the selected 
case.

7. Select a value for the Reason field.

8. Enter the appointment length of time in the Length field. Enter the date in the Date field.

9. Enter the time in the Time field. 

10. Select a button for the Status of the appointment. The default value is Unconfirmed.

11. If necessary, click Need Referral to indicate the patient does not have a referral for his or her 
visit. 

12. If the patient must make a co-payment, click Enter Copay. This will open the Enter Copay 
screen on which you can enter the patient’s co-payment.

13. Click the Save button. The appointment appears on the Appointment Grid.

Find Open Time
You can use the Find Open Time feature to have the program search for the next available opening 
for an appointment. To do so

1. On the Edit menu, click Find Open Time. The Find Open Time screen appears.

Figure 140.  Find Open Time screen

2. Complete the fields and click the Search button. Office Hours shows you the next available 
time on the grid.

Go To Date
If you need to locate a date that is a given length of time in the future, use the Go To Date screen. 
To do so
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1. From the Edit menu, click Go to Date. The Go to Date screen appears.

Figure 141.  Go To Date screen

The date that defaults in the Date From field is the date that is currently selected in the 
calendar.  If you want to change the date in the Date From field, replace it by either highlighting 
and typing in a new date, or click in the field or on the down arrow to the right of the field and 
the calendar opens.

2. Enter a number in one of the selection boxes to indicate how far in the future you need to make 
the appointment. For example, if you need an appointment in six months, type the number 6 in 
the Months field.

3. Click the Go button. 

Wait List
The Wait List is available to track any unexpected patients who need to be seen that day. If no 
openings are available when patients call in, you can put them on the Wait List. If a time slot 
becomes available, you can use the Wait List to help you determine whom to call first for that 
opening.

Moving a Patient from the Wait List to an Open Appointment
1. On the View menu, click Wait List. The Wait List screen appears.

2. Use the Search/Sort by fields to search for a record. Select the field by which you want to 
search in Sort by and then enter the value for which you want to search in Search.

3. Select the Provider.

4. Choose a patient from the list and click and drag their name to an open time slot in the 
Appointment Grid. 

Adding a Patient to the Wait List 

To create a new entry for the Wait List:
1. On the View menu, click Wait List. The Wait List screen appears.

2. Click the New button in the Wait List. The New Wait List Appointment screen appears.  

3. Select a patient in the Chart Number field. The patient’s name and phone number are 
automatically entered in those fields when you tab past them. 
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NOTE: Entering a phone number here does not store that number in the patient’s record. To 
include a phone number in the patient’s permanent record, enter the phone number in the Patient/
Guarantor screen. You can move the cursor back to the Name field, and then press F9 to edit the 
patient record.

4. Complete the remaining fields on the New Wait List Appointment screen.

5. Click the Save button. 
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Editing an Appointment

To edit an appointment:
1. Double-click the appointment or right-click the appointment and click Edit from the drop-down 

menu. The Edit Appointment screen appears.

2. Make the changes you want.

3. Click the Save button.

Changing a Telephone Number or Cell Phone
If you update a patient's appointment with a new telephone number, you can also update all future 
appointments with the new phone number. When you enter the new phone number and click, the 
following screen appears:

Figure 142.  Confirm Phone Change screen

 • If you click the Yes button, all future appointments are updated.

 • If you select the Do not show this message again check box, the Confirm Phone Change 
screen will not appear in the future when you change other telephone numbers; the system will 
automatically update the phone number. 

 • If you click the No button, the patient’s phone number for all future appointments will remain 
the old phone number. 

Changing Other Information
If the field has an arrow key, you can click the arrow and then select from the drop-down list. If the 
field has a Search icon, you can click the icon and search for the corrected information. 
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Viewing Scheduled Appointments

You can view all the appointments scheduled for a patient. 

1. On the Lists menu, click Patient List. The Patient List screen appears.

2. Highlight the patient whose appointments you want to view and click Edit Patient. The 
Patient/Guarantor screen appears.

3. Click the Appointments button on the right. The Scheduled Appointments screen appears.

Figure 143.  Scheduled Appointments screen

 • Click Show all appointments to view all appointments for this patient. 

 • Click the Edit button to edit the selected appointment. 

 • Click the New button to create a new appointment.

 • Click the Delete button to delete the selected appointment. 

 • Click the Print button to print the appointments in the grid. 

 • Click the Close button to exit the screen.
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Viewing Future Appointments 

You can see the future appointments for each patient. Future appointments can be scheduled for 
up to a year in advance. When you open the Future Appointments screen, however, only the next 
60 days of appointments, based on the current system date, will appear. The future appointments 
that appear in this screen will change as the system date advances. 

Using the Future Appointment List screen
1. Right-click the patient's appointment on the Appointment Grid and click Future 

Appointments. The Future Appointments List screen appears. It will show you appointments 
for this patient for the next 60 days. 

Figure 144.  Future Appointment List (next 60 days screen)

2. Click the Print Grid button to print the list or click the Close button to exit.

Using the Edit Appointment screen
Medisoft will also notify you if the patient has future appointments scheduled when you open the 
Edit Appointment screen.

1. From the Appointment grid, right-click an appointment and click Edit.

2. Press Tab to move the cursor to the Home Phone field.
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3. If the patient has future appointments scheduled, you will see the notification on the screen.

Figure 145.  Edit Appointment screen with future appointment notification

4. Click the magnifying glass to open the Scheduled Appointments screen. 

You can see all of the patient’s appointments from this screen. You are not limited to the next 60 
days.
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Rescheduling an Appointment

You can reschedule an appointment by opening it and changing its status to Rescheduled. The 
Wait List will open, allowing you to find an open appointment time for the patient.

To reschedule an appointment:
1. On the Appointment grid, right-click the appointment and click Rescheduled. The Wait List 

screen appears. 

Figure 146.  Wait List screen 

2. On the Wait List screen, click the Find button. The Find Open Time screen appears.

3. On the Find Open Time screen, select/modify criteria for selecting a new appointment.

4. Click the Search button. The Confirm screen appears.

5. On the Confirm screen, select one of these options

 • Click Yes to set the appointment.

 • Click No to reject the appointment. 

 • Click Retry for the next available appointment.
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Moving/Deleting an Appointment

Moving an Appointment
To move an appointment, select one of the following methods:

Drag and Drop (changing to same day only):
1. Click the appointment and hold the mouse button down.

2. Move the cursor to the new appointment time.

3. Release the mouse button. 

Using accelerator keys:
1. Highlight the appointment by clicking the grid cell.

2. Press ALT + X to cut the appointment.

3. Move to the new date on the Appointment Grid.

4. Click the new appointment time.

5. Press ALT + V to paste the appointment in the new location.

Using the Speed menu:
1. Highlight the appointment by clicking the grid cell.

2. Right-click the mouse and click Cut.

3. Move to the new date or new time.

4. Click the new appointment time.

5. Right-click the mouse and click Paste.

Using the Edit menu:
1. Highlight the appointment by clicking the grid cell.

2. On the Edit menu, click Cut.

3. Move to the new date.

4. Click the new appointment time.

5. On the Edit menu, click Paste.

Deleting an Appointment
To delete an appointment

1. Highlight the appointment on the grid by clicking it.

2. Right-click and click Delete.

NOTE: When you delete an appointment to which a numbered superbill is attached, the superbill is 
also deleted. The number may be released for reassignment.
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Recalling Patients

The Patient Recall List screen displays all patients who have been set up for appointment recalls. 
The recall list provides staff a list of patients who need to be contacted for various reasons, for 
instance, contacting a patient regarding a follow-up visit or paying a bill.

This screen is for information purposes only and it does not integrate with any other part of Office 
Hours.

To open the Patient Recall List:
1. On the Lists menu, click Patient Recall. The Patient Recall List appears.

Figure 147.  Patient Recall List screen

This screen is different from the other lists because you can search for a record by its date. When 
using the date as a search parameter, there are various date formats you can use. The following 
table explains the formats that are acceptable to use when searching. 

2. From this screen, you can

 • Click the New button to add a new entry.

 • Click the Edit button to update an existing entry.

 • Click the Delete button to remove an entry.

 • Click the Print Grid button to print a list of patients on this list. 
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Setting Program Options

There are several options you can choose from. You can access Program Options from the 
Program Options option on the File menu.

Options tab

Figure 148.  Program Options - Options tab

Set the starting and ending appointment times for the practice.  Enter the Starting Time and 
Ending Time, breaking it down by hour and minutes.  Standard appointment Intervals can be 
established by scrolling with the up and down arrows.  

You can also set colors to distinguish appointments, breaks, and conflicts.  Make decisions 
concerning all the other default settings in this tab.

Designate one of the reports in the Speed Report box and it will automatically print when you click 
the Print speed button.

You can now choose to use Deposit Entry or Transaction Entry when entering a copay.  To use 
Transaction Entry rather than Deposit Entry, click the Use transaction Entry to Make Copays check 
box.  
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Multi Views tab

Figure 149.  Program options - Multi Views tab

Office Hours provides one Multi View setup, which automatically includes all providers and all 
resources, each with its own column. You can create as many Multi Views as you need in the Multi 
Views tab.   

The open data entry field lists all Multi Views that have been set up. This is where you can group 
providers and/or resources (rooms or facilities scheduled for appointments) in any combination 
desired, or modify or delete existing multiple view setups.  Click the New button to set up a new 
Multi View (select a view and click the Edit button to make changes).  
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In the New View screen, assign a name for the new view. For the first column, indicate the type 
(Provider or Resource), the Code (provider number or resource code), then the width of the column 
(in pixels). Set up each column you want in the view and click the Close button when finished.  

Figure 150.  New View tab

If you want to add a column between columns that have already been created, place your cursor 
where you want the new column and click Insert. 

These views can be also edited or reverted to default views through the View menu.
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Appointment Display tab

Figure 151.  Appointment Display tab

In the Appointment Display tab, you can specify up to five rows of information to display in the grid 
for an appointment. Be aware that the length of the appointment determines how much data is 
actually displayed on the grid. An appointment must be at least 75 minutes long to display five rows 
of information.



Medisoft 21 Service Pack 1
162  February 2017

Appointment Display tab Chapter 23 - Scheduling Appointments



Medisoft 21 Service Pack 1
February 2017   163

Chapter 24 - Reports

In this chapter you will learn about reports in Medisoft.

Reports Overview

Medisoft offers flexible reporting options.You can run reports in Medisoft by selecting various 
reports from the Reports menu. In addition, you can launch the Medisoft Reports application (for 
Medisoft Advanced and Medisoft Network Professional only) and complete all reporting tasks 
there. The Medisoft Report application offers several key features not available when running 
reports from the Reports menu, including different reports and features to enhance productivity. 

Report Procedures

Viewing a Report
You can view or preview a report before printing or exporting it.  For example, you could preview a 
Patient Aging report before printing it to make sure that you have selected the most appropriate 
data criteria. After previewing, you can export or print the report.

To view a report: 
1. On the Reports menu, select the report you want to view. The Print Report Where? screen 

appears. 

2. Select Preview the report on the screen. 

3. Click the Start button. Depending on the report selected, the Data Selection Questions screen 
or the Search screen opens. 

4. Select ranges and then click the OK button. The report appears. 

NOTE: For some reports that use a different format, such as statements, the controls in this screen 
are slightly different and include a Save Report to Disk option.  

Printing a Report

To print a report: 
1. On the Reports menu, select the report you want to print. The Print Report Where? screen 

appears.

2. Select Print the report on the printer. 
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3. Click the Start button. Depending on the report selected, the Data Selection Questions screen 
or the Search screen opens. 

4. Select ranges and click the OK button. The Print screen appears.

5. Click the OK button. 

Exporting a Report 
You can export a report into another format. For example, you could export a Patient Aging report 
to a Microsoft Excel spreadsheet. 

To export a report:
1. On the Reports menu, select the report you want to export. The Print Report Where? screen 

appears.

2. Select Export the report to a file and click the Start button. The Save As screen appears.

3. Select a file format for exporting and a destination. 

4. Click the Save button. The Search screen or the Data Selections Questions screen appears 
(depends on the report or statement selected).

5. Select appropriate criteria and click the OK button. The report is exported. 

Searching for a Specific Detail in a Report
Once you have generated a report, you can further refine the report and search for a more detailed 
data element. When using this feature, you essentially re-run a report using more specific data 
criteria.    

To refine your data criteria and search for specific data:
1. View a report. See “Viewing a Report” on page 163.

2. Click the Search button. The Search screen appears.

3. Select specific data ranges.

4. Click the OK button. The report displays using the new search criteria.  
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Available Reports

Not only does Medisoft build an accounts receivable file and handle statements, insurance claims, 
and electronic billing, it also provides a variety of reports that can give you a better understanding 
of the day-to-day workings of your practice.

Among the reports generated within Medisoft are Day Sheets, Analysis Reports, Aging Reports, 
Productivity Reports (Network Professional), Activity Reports (Network Professional), Collection 
Reports (Advanced and Medisoft Network Professional), Audit Reports, Patient Ledger Report, 
Guarantor Quick Balance List (Network Professional only), and Standard Patient List Reports.  

You can also print a title page that shows all the filters used in preparing the report.   

Day Sheets 
Day Sheets are available in three reports. 

Report Description

Patient Lists each patient’s name, showing all transactions and a summary of 
activities for the day.

Procedure Breaks down by procedure code the activities of the day, summarizing 
patients treated for each procedure.

Payment Shows the payments made on the requested day and the charges to which 
the payments are applied.
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Analysis Reports
Report Description

Billing/Payment Status Report (Advanced and 
Medisoft Network Professional)

Provides a thumbnail sketch of the current 
billing and payment status of each claim. The 
report shows what has been billed and not 
billed, what is delayed for some reason, if the 
carrier is not responsible or has refused the 
claim, or if the claim is paid in full. An asterisk 
(*) next to an amount indicates that the entity 
has paid all it is going to pay; and the balance, 
if any, should go to the next responsible payer.

Insurance Payment Comparison (Network 
Professional only)

Compares the payment records of all carriers 
in the practice.

Practice Analysis Summarizes the activity of a specified period 
(for example, a month), listing each procedure 
performed, the number of times it was 
performed, and the total dollar amount 
generated by each procedure. It shows the 
average charge, includes any costs involved 
with that procedure, and calculates the net 
monetary effect on the practice’s income.  

Insurance Analysis (Advanced and Medisoft 
Network Professional)

Summarizes all claims filed by category 
(Primary, Secondary, and Tertiary).  Claims 
totals are shown for charges and insurance 
payments in both dollar amount and 
percentage.   

Referring Provider Report (Advanced and 
Medisoft Network Professional)

Shows which patients were referred by other 
practices and the percentage each referral 
contributes to the overall referred income of the 
practice, as of the date of that report. The 
report also includes the UPIN of the referring 
provider. By blanking out the Referring 
Provider range in the Data Selection Questions 
screen, a report can be generated showing 
what percentage of the entire practice has 
been referred.
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Referral Source Report (Advanced and 
Medisoft Network Professional) 

Assembles the patient list by source (other 
than provider) and shows how much revenue 
comes from each source, allowing the practice 
to identify those sources that send profitable 
referrals and/or limit those that are costly or 
nonproductive.  

This is another report for tracking the source of 
patients who come to the practice. For the 
report to work, however, all referral sources 
must be entered in the Address Book. A 
source can be an attorney, a hospital, friends, 
other patients, or anything else. Most new 
patient application forms include the inquiry 
“How did you hear about us?”  

Facility Report (Network Professional only) Tracks patients who are seen at different 
facilities. The Facility Report assembles the 
patient list by facility and shows how much 
revenue comes from each facility, helping you 
identify which generates the most money.

Unapplied Payment/Adjustment Report 
(Advanced and Medisoft Network Professional)

Shows any payment or adjustment that has an 
unapplied amount and where the transaction 
can be found.  

Unapplied Deposit Report (Advanced and 
Medisoft Network Professional) 

Shows all deposits that have an unapplied 
amount.

Co-Payment Report (Advanced and Medisoft 
Network Professional) 

Shows all patients who have co-payment 
transactions. It shows the amount of the 
required co-payment, how much was applied, 
and what was left unapplied. If a patient does 
not have any co-payment transactions, he or 
she is not included in the report.    

Outstanding Co-Payment Report (Advanced 
and Medisoft Network Professional)

Shows all patients who have outstanding co-
payment transactions. The report shows the 
Co-payment amount expected, the actual 
amount paid, and the amount due. If a patient 
has no outstanding co-payment transactions, 
he or she is not included in the report.

Appointment Eligibility Analysis - Detail Report Shows patients with appointments whose 
eligibility has been checked, based on criteria 
entered. It includes detail about the patients, 
their appointment date and time, the provider 
name, and reason code. It is an ARRA report 
designed for showing that the practice is 
verifying eligibility electronically.

Report Description
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Appointment Eligibility Analysis - Summary 
Report 

Shows a summary of appointments whose 
eligibility has been checked, based on criteria 
entered. It is an ARRA report designed for 
showing that the practice is verifying eligibility 
electronically.

Electronic Claims Analysis - Detail Report Shows the status of claims, providing a 
summary of total claims and those that have 
been filed electronically or by paper. It includes 
the percentage of claims filed electronically. In 
addition, it shows detail such as the billing 
date, insurance carrier, sequence, claim 
number, patient chart and name, and the 
status of the claim. It is an ARRA report 
designed for showing that the practice is 
sending claims electronically.

Electronic Claims Analysis - Summary Report Shows the status of claims, providing a 
summary of total claims and those that have 
been filed electronically or by paper. It is an 
ARRA report designed for showing that the 
practice is sending claims electronically.

Report Description
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Aging Reports 

Production Reports 

NOTE: This is a Network Professional only feature.

Report Description

Patient Aging Shows patient aging. Default aging criteria is 
based upon the number of days between the 
creation of the transaction or claim and the date of 
the report you are generating. The columns break 
down the amounts due that are 30, 60, and 90+ 
days old. Aging is from actual date of the 
transaction, so it reflects the true age of the 
account. The aging criteria and columns can be 
altered in Program Options.  This report includes 
all unapplied amounts in the totals. The Date filter 
has been removed as it would return invalid 
values.  

Patient Remainder Aging (Advanced and 
Network Professional only) 

Has the same format as the Patient Aging, but 
there is a key difference in how it works.  A charge 
does not show up on the Patient Remainder Aging 
report until all insurance responsibility has been 
marked complete.  

Patient Remainder Aging Detail (Advanced 
and Network Professional only) 

Has the same criteria as Patient Remainder Aging 
Detail. However, it also lists each insurance 
company on the patient’s account and the date the 
insurance payment was marked complete.  

Insurance Aging and Summary Track aging of claims filed with insurance 
carriers. The summary versions are similar but no 
patient information is included. 

Report Description

Production by Provider, Procedure, and 
Insurance and Summary

Gives incoming revenue information for 
each provider, procedure, or insurance 
carrier, respectively. 
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Activity Reports 

NOTE: This is a Network Professional only feature.

Collection Reports 

NOTE: This is an Advanced and Medisoft Network Professional feature.

Report Description

Daily/Monthly Activity Report Presents financial activity based on the 
date range selected. The report displays 
the total number and the total amounts of 
the charges, payments, and adjustments 
entered during a date range. The report 
also details the net effect of the financial 
information entered on the Accounts 
Receivable balance for the day/month.

Activity Summary by Provider/Insurance 
and Procedure 

Breaks down financial activity by day or 
month. The summary reports summarize 
financial information entered for each 
provider/procedure or insurance carrier, 
respectively.

Report Description

Patient Collection Report Contains information based on statements 
marked Sent in the Statement 
Management screen, showing what has 
not been paid, statement date, and so 
on. Also, select this Patient Collection 
Report to generate the report with 
statement notes included.

Insurance Collection Reports Shows the claim data, what amount is 
outstanding, and so on. These reports also 
offer variants that include claim notes. 

Patient Collection Letters Printed in preparation of collection letters.  
It contains information from the collection 
list and is used to help evaluate 
collections.  

Collection Tracer Report Reports how many collection letters have 
been sent and when. Each time collection 
letters are printed, Medisoft, by default, 
keeps track of each letter sent.  
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Audit Reports
Report Description

Audit Generator Creates a data audit report that contains only the 
information you want included in the report. This 
report is intended as a protection for the practice to 
keep track of changes made and by whom.

Some PHI (personal health information) will be 
included in the Data Audit Report no matter what 
selections are made or excluded in the Program 
Options screen or the Audit Generator.

NOTE:  This report does not support printing a 
report title page even if the Print Report Title Page 
option was set in the Program Options screen.
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Chapter 25 - Program Options

This chapter gives a brief overview of the different program options available in Medisoft.

General Tab

The General tab has options for backups, which are an essential part of maintaining computer-
generated billing programs, and general default settings, such as which screen to open on startup, 
and several options to show or hide data. 

Figure 152.  Program Options screen - General tab
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Data Entry Tab

The Data Entry tab gives you many options for various sections of Medisoft. 

Figure 153.  Program Options screen - Data Entry tab

In the Global section, you can indicate whether to use the ENTER key to move between fields, to 
force payments to be applied, and to multiply unit times amount. When the Suppress UB04 Fields 
check box is selected, UB-04 fields do not appear throughout Medisoft. 

In the Patient section, you can choose to use numeric chart numbers (the default is to use an 
alphanumeric code) and/or have Medisoft automatically hyphenate Social Security numbers. The 
Patient Quick Entry Default list and the Use Quick Entry for New Patient/Case F8 and Use Quick 
Entry for Edit Patient/Case F9 check boxes provide setting options for the Patient Quick feature, 
which provides a custom method for creating records.  
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Payment Application Tab 

NOTE: This is an Advanced and Medisoft Network Professional tab.

In the Payment Application tab, you can establish default settings that affect payments when you 
apply them to patient balances.  

Figure 154.  Program Options screen - Payment Application tab

If you choose to accept the default settings, any amount applied to a charge is automatically 
marked as paid by that particular payee, the allowed amount is automatically calculated, and the 
difference between the calculated allowed amount and the practice charge is offset in the 
Adjustment column. In addition, any claim that has received payment from all responsible payers is 
automatically marked “Done.” 

In the lower half of the screen, select default billing codes to be applied when using this feature.  
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Aging Reports Tab

The Aging Reports tab lets you alter the starting date for patient aging reports and to redefine 
aging columns for both patient and insurance aging reports.  

Figure 155.  Program Options screen - Aging Reports tab
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HIPAA Tab/ICD 10

The HIPAA tab offers features designed to help protect patient information from unauthorized 
access.  

Figure 156.  Program Options screen - HIPAA/ICD 10 tab

The Auto Log Off check box is designed to protect your data files from unauthorized 
tampering. Select the check box and then enter a number of minutes (up to 59) in the field. With 
Auto Log Off activated, any time Medisoft remains unused for the amount of time designated, it 
locks the practice and requires re-entry of a password to access Medisoft again.

If you select this check box and have not used the Security Setup feature in Medisoft, a message 
pops up telling you that security has to be set up before the backup will function. For more 
information on security, see “Security Setup Overview” on page 35.  

When the Warn on Unapproved Codes check box is selected, Medisoft alerts you if a code entered 
or selected is non-HIPAA compliant. This warning pops up every time you save transactions and 
Medisoft finds a code that has not been marked HIPAA compliant. 
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Color-Coding Tab 

NOTE: This is an Advanced and Medisoft Network Professional tab. 

Transactions
If you want to use color coding for transactions in Transaction Entry and Quick Ledger, select the 
Use Color Coding check box.  

Select colors for each of six types of transactions: unsaved, no payment, partially paid, overpaid 
charge, unapplied payment, and overapplied payment. These colors appear in both screens, 
letting you know at a glance the status of the transaction.

Figure 157.  Program Options screen - Color Coding tab

Patients
This feature, called patient flagging, lets you color code patient records to alert you to various 
situations when viewing records.

The patient flag colors in the Program Options screen are fixed and cannot be edited. In the box to 
the right of a color box, assign your own description to that flag color. To activate the edit boxes, 
select Use Flags.  

Patient flags are connected to patient records in the Other Information tab of the Patient/Guarantor 
screen as you edit or set up a new patient record.  
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Billing Tab 

NOTE: This is an Advanced and Medisoft Network Professional feature. 

Statements
Options in the Statements section deal with billing cycles. If you want to use billing cycles when 
sending statements, select the Use Cycle Billing checkbox. If you choose to use cycle billing, be 
sure to enter a cycle billing days interval (for example., every 30 days). For more information on 
billing cycles, see “Billing Cycles” on page 121. Statements sent through BillFlash are also affected 
by the billing cycle.

The Add Copays to Remainder Statements is used to add missed copays (when patients do not 
immediately pay their copay), to the patient’s Copay Remainder statement. 

Figure 158.  Program Options screen - Billing tab 

Billing Notes
When you select Create statement billing notes, Medisoft adds a note to statements when 
printed. Be sure to select a default note in the Statement Billing Note Code field.  

When you select Create claim billing notes, Medisoft adds a Comment transaction line in both 
Transaction Entry and Quick Ledger whenever a claim is billed. The note includes the carrier 
name, date billed, claim number, and the name of the provider associated with the claim.  Be sure 
to select a default Claim Billing Note Code.  
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Audit Tab 

The Audit tab lists all tables available in the database. The tables you choose here become 
available in the Audit Generator when preparing the Data Audit Report. 

Figure 159.  Program Options screen - Audit tab
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BillFlash Tab 

The BillFlash tab allows you to control some of the information that appears on the statements you 
send electronically via BillFlash, the web based company that is set up to process electronic 
statements in Medisoft. 

Figure 160.  Program Options screen - BillFlash tab
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Chapter 26 - Backup and Restore Data

In this chapter you will learn how to back up and restore data using both the regular and 
hot backup/restore features. 

Backing Up Your Data 

Making regular backups is essential to good maintenance of your data. 

Best Practice--consider backing up data files every day so you can restore lost data to 
the most recent date before the files were damaged or corrupted. If you are working with 
multiple practices, each practice will have its own set of backup files. Doing your backups 
within the Medisoft program is a dependable method. 

Important! Prior to making a backup, you must stop the MPIC service and the Mobile 
service. Follow these steps to stop those services.

1. Click the Start button.

2. Enter services in the Search programs and files field.

3. Press Enter. The Component Services screen appears. 

4. Click Services (local). The list of services appears.

5. Find McKesson MSL Mobile Api Server. Right-click and select Stop.

6. Find MPICservice. Right-click and select Stop.

7. Launch Medisoft, open your practice, and make a backup.

8. Return to the Component Services screen and restart McKesson MSL Mobile Api 
Server and MPICservice.

To make a backup: 
1. On the File menu, point to Backup, and click Backup Data.
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2. Click the OK button on the warning message. The Medisoft Backup screen appears. 

Figure 161.  Medisoft Backup screen 

3. Complete the fields on the screen. 

4. Click the Start Backup button.

5. Click the OK button on the message that the backup is complete. 

Restoring Your Data 

You will very seldom have to restore a backup. it is only necessary if the data becomes 
corrupted or you have to print reports that are no longer accessible because of the 
addition of new data. e-MDs highly recommends that you create a new backup of your 
current data BEFORE you restore your backup. You may need this backup to restore your 
files to their current state. 

To restore a backup: 
1. On the File menu, point to Restore, and click Restore Backup. 
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2. Click the OK button on the warning message. The Medisoft Restore screen appears. 

Figure 162.  Medisoft Restore screen 

3. Select a backup on the list of existing backups or click Find to find a different backup. 

4. Click the Start Restore button. A confirmation screen appears. 

5. Click the OK button.The backup is restored. 

6. Click the OK button. 

7. Click the Close button on the Medisoft Restore screen. 

Making a Hot Backup 

This feature is for Medisoft Network Professional only. 

Hot Backup allows you to make a backup of your data while other users are still working in 
the practice. Hot Backup will ensure that processes are completed before creating the 
backup. Once the backup is complete, you will be logged out of Medisoft and must log 
back in to resume work.
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To make a hot backup: 
1. On the File menu, point to Backup, and click Hot Backup. The Medisoft Hot Backup 

screen appears. 

Figure 163.  Medisoft Hot Backup screen 

2. Complete the fields on the screen. 

3. Click the Start Backup button. 

4. Click the OK button on the message that the backup is complete. 

Restoring Your Hot Backup 

You will very seldom have to restore a hot backup. it is only necessary if the data becomes 
corrupted or you have to print reports that are no longer accessible because of the 
addition of new data. e-MDs highly recommends that you create a new backup of your 
current data BEFORE you restore your backup. You may need this backup to restore your 
files to their current state.
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To restore a hot backup: 
1. On the File menu, click Restore. 

2. Click Hot Restore. 

3. Click the OK button on the warning message. The Medisoft Hot Restore screen 
appears. 

Figure 164.  Medisoft Hot Restore screen 

4. Select a backup on the list of existing backups or click the Find button to find a 
different backup. 

5. Click the Start Restore button. A confirmation screen appears. 

6. Click the OK button.The backup is restored. 

7. Log back into Medisoft.
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Chapter 27 - Configuring a Mobile Device

You can configure the following mobile devices with Medisoft: iPad.

Once a device is configured to work with Medisoft, you can perform patient intake, view 
appointments, enter charges for patients, and create/update superbill templates.

You will need to download and install the application to your mobile device and then enter the API 
Key and Code to activate it.

To use a mobile device with Medisoft, you must install BOTH Advantage Database Server AND 
Medisoft Client on the server computer. Medisoft Client MUST be installed on the same computer 
as Advantage Database Server. 

Security
eMDs’ Mobile Application utilizes HIPAA compliant data transmission safeguards, such as 
encryption and authentication for all Mobile Application connections and communication to secure 
and maintain confidentiality of data.

Supported Devices
For information, see the Medisoft installation guides.

Firewall/Router Considerations for Your Server
Depending on what firewall you use (other than Windows firewall) and what router you use, you 
may need to update the exception list or you may need to manually open certain ports. You will not 
be able to connect to a mobile device until the firewall and router settings are updated.

If your firewall has an exception list, make sure that the following program is added to the exception 
list: PlutoServer.MSL.exe.

If your firewall and/or router requires you to open ports, make sure the following TCP ports are 
open: 

To determine which incoming TCP port you need to open, follow these steps:

Port

443 Outgoing 

A port in the range 49000-50000 incoming 
- do NOT open the entire range. 
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1. Click Start, point to All Programs, and click Diagnose Mobile. The Diagnose Mobile screen 
appears.

Figure 165.  Diagnose Mobile screen

2. Note the Local IP, External IP and External Port.

3. Verify that the Local IP is the correct IP address of your server.

4. Configure your router/firewall to accept connections on the External IP and External TCP Port, 
and forward them to the Local IP on TCP port 1945.  The steps required vary depending on 
your particular router or firewall.  Please consult your router or firewall documentation.

5. Click the Is Server Reachable button verify that your firewall/router are correctly set up to 
accept connections.

To configure your device
1. Start Medisoft.
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2. On the Help menu, click Mobile. The Mobile screen appears. By default, only Level 1 users, 
such as system administrators, have access to mobile functionality. If you do not have Level 1 
privileges in Medisoft, see your Medisoft Administrator for access. 

Figure 166.  Mobile screen

3. Take note of these values on the Mobile screen.

4. With your mobile device, launch the App Store. 

5. Search for Medisoft by McKesson.

6. Download and install the application for Medisoft.

7. On the mobile device desktop, double-tap the mobile application. The application starts.

8. Enter the API Key and API Code that you noted.

9. Tap Authenticate. The application will connect to your Medisoft practice data. 

10. Log in to your practice using your Medisoft User ID and Password.

To add another practice
If you have more than one practice, follow this procedure to add another practice.

1. In Medisoft, log into the practice that you want to access from your mobile device.

2. On the Help menu, click Mobile. The Mobile screen appears.

3. Take note of the API Key and API Code. These will be different for each practice.

4. Launch the mobile application.

5. Tap Add. 

6. Enter the API Key and Code that you noted. 

7. Tap Save. 

Troubleshooting
You can test your connection using the Check Access button on the Mobile screen. 

To open the Mobile screen:
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1. On the Help menu in Medisoft, click Mobile. The Mobile screen appears.

Figure 167.  Mobile screen

2. Click the Check Access button. Connectivity is checked and the status appears.

Figure 168.  Mobile screen with connectivity checks 

If you receive a Failed on any of the checks, here are some possible solutions:

Connectivity Check Possible Solutions for a Failed status

Checking connectivity to mobile 
service

If this fails, Medisoft could not connect to 
the Mobile Service (the application that 
enables your mobile device to connect to 
your Medisoft practice data). 

 • Make sure the mobile service is 
installed on the server. You must have 
Medisoft Client installed on the server 
if you want the mobile service 
installed there as well.

 • The mobile service is not started. 
Check your services to make sure it is 
started.
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Updating the Superbill Template
You can update the superbill template by adding, changing, or deleting sections and items.

To open the superbill template:
1. On the mobile device, launch the Medisoft application and log in.

2. Tap the Setup icon at the top of the screen. The Superbill template appears.

Checking outgoing connectivity

If this fails, the Mobile Service could not 
connect to the Internet for outgoing data.

 • Check your network cable and verify 
that your computer can reach the 
Internet.

 • Verify that port 443 is open. Consult 
the documentation for your firewall to 
learn how to open these ports, or 
contact your IT administrator/

 • If you continue to experience 
problems, check your documentation 
or contact Technical Support.

Checking incoming connectivity

If this fails, the Mobile Service could not 
connect to the Internet for incoming data. 

NOTE: If the check for incoming 
connectivity fails but the other two checks 
passed, you can still use a mobile device 
as long as the mobile device is on the 
same network as the server.

 • Check your network cable and verify 
that your computer can reach the 
Internet.

 • If you have a firewall other than 
Windows firewall, verify that the port 
for incoming data is open (see 
“Firewall/Router Considerations for 
Your Server” on page 189). Consult 
your IT administrator to open the 
correct port.

 • Verify that your router is UPNP 
enabled.

 • If you continue to experience 
problems, check your documentation 
or contact Technical Support.

Connectivity Check Possible Solutions for a Failed status
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Figure 169.  Superbill template

To add a section:
1. Tap Add Section at the top of the screen.

Figure 170.  Add New Section screen

2. Enter a title for your new section and tap Done. The new section appears on the screen.
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Figure 171.  Superbill Template

3. Next, add items to the section. To do so, tap the + icon. You can select one of five types of 
items:

Icon Description

Tap this icon to add fields to a section.

Tap this icon to remove the section and the fields in the section.

Tap this icon to edit the section and the fields in the section.

Tap this icon to move the entire section one section toward the top of the 
template. If it is currently a right side section, it will move to the left side. If it is 
currently a left side section, it will move up a row and to the right side.

Note: You must save a section prior to moving it to a different position on the 
template.

Tap this icon to move the entire section one section toward the bottom of the 
template. If it is currently a left side section, it will move to the right side. If it is 
currently a right side section, it will move down a row and to the left side.

Note: You must save a section prior to moving it to a different position on the 
template.

Tap this icon to reorder the fields in the section. 

Icon Description

+P Opens the Search Procedure screen so 
you can add a procedure.

+D Opens the Search Diagnosis screen so 
you can add a diagnosis.

+F Opens the Add Free Text screen so you 
can add free text to your new section.

+C Opens the Add Canned Text screen so you 
can add canned text to your new section. 

+U Opens the Add URL screen so you can 
add a URL for a web page.
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4. When you click an icon, the appropriate screen appears.

Figure 172.  Search Diagnosis screen

5. Enter characters to search for the item and tap Search. The list of item appears.

6. Tap the item you want and tap Add. The item appears in your new section. 

Figure 173.  Section 

7. Tap Save to save the template.

To edit a section:
1. Tap the Edit icon. The Edit screen appears.

2. Tap Section.

3. Make your changes.

4. Tap Done.

5. Tap Save to save the template.
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To edit a field in a section:
1. Tap the field in the section to select it.

2. Tap the Edit icon. The Edit screen appears.

3. Tap Selected Field.

4. Make your changes.

5. Tap Done.

6. Tap Save to save the template.

To remove a section:
1. Tap the X icon on the section.

Figure 174.  Section

The Remove screen appears.

Figure 175.  Remove section

2. Tap Section. The section is removed.

3. Tap Save to save the template.

To remove a field from a section:
1. Highlight the field you want to remove.

2. Tap the X icon for the section. The Remove screen appears.

3. Tap Selected Field. The selected field is removed.

4. Tap Save to save the template. 
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Glossary

This section defines terms used in the Medisoft 21 Service Pack 1.

Care Plan Oversight Number
This is the number physicians have if they have supervision of Medicare patients under the care of 
hospices or home health agencies that require complex or multidisciplinary care.

CLIA Number
This is Clinical Laboratory Improvement Amendment Number. This number is required for all 
laboratory claims. 

EDI Receivers
These are the organizations to which you send claims or eligibility requests.

Encoder Pro
Encoder Pro is a  medical coding solution that works in conjunction with Medisoft to search ICD‐
9‐CM, ICD‐10‐CM, CPT, and HCPCS Level II code sets. Encoder Pro provides information from 
Medicare policies and Optum publications, and helps to confidently select the proper codes 
quickly and accurately..

EOB
An EOB is one or more ready-to-mail forms containing claim-specific information. Each form lists 
the carrier’s payments, allowances, and insurance filing activity. EOBs are used mainly to inform 
secondary carriers of the payments and disallowances posted to a claim by the claim’s primary 
carrier. 

Insurance Class
Insurance classes enable you to categorize insurance carriers into groups.

Legacy identifier
This refers to a provider number or identification number other than NPI, such as a BCBS provider 
number, Unique Provider Identification Number (UPIN), Medicare number or Medicaid number.

Level One user
This is a user with the highest access level in Medisoft, often an administrator.

List screen
These are screens that show lists of information, such as providers, insurance carriers, and so on. 
From these screens you can select an item to edit or create a new item for the list.

Mammography Certificate Number
The Mammography Certification Number is assigned to a provider certified to perform a 
mammography and is required on all mammography claims. 

McKesson Practice Interface Center (MPIC)
This is an interface application that can be installed and configured to connect Medisoft with other 
applications. 
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National Provider ID
This refers to a unique number for a physician or practice that identifies them.

Open Item Accounting
A type of accounting where charges and payments for patients remain on the books and are not 
lumped together at the end of a fiscal period or year.

Provider Class
The provider class is a way of categorizing providers into groups. 

Quick Ledger
The Quick Ledger is a feature of Medisoft that gives a quick reference for transaction and other 
information in the patient’s account.

Revenue Management
This is the application that is bundled with Medisoft that enables a user to transmit claims and 
eligibility payments electronically. 

Rules
Rules are logic patterns set up in Medisoft to ensure that claims are processed correctly for 
providers and practices based on requirements set by the government and insurance carriers. 

Superbill
The superbill is designed to be a physician's worksheet. The superbill displays a list of what 
procedures can be performed by the provider and the diagnoses related to it displayed in a list 
format.

Taxonomy Number
This is a number that specifies the type of practice the physician is in, for example, family practice 
or emergency medicine

UB-04
This is a form used by institutions to file claims to insurance carriers.

Unique Physician Identification Number (UPIN)
The Unique Physician Identification Number (UPIN) is a number assigned to physicians and others 
who are enrolled in the Medicare Program.
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